5 |
=_HFl Introduction
Four Winds is a computer version of Mah Jong, the traditional Chinese game of tiles for four players.

Though the origins of Mah Jong are ancient, the history of the game as it is known today only extends to
late 19th century. The game was introduced in USA early in the 20th century and is now popular all over
the world.

Mah Jong resembles card games like Gin Rummy or Canasta, but it is played with tiles made of mother-
of-pearl, fish bone or ivory (nowadays usually of plastic) with figures and kaniji characters engraved on
them. The backside of the tiles is made of bamboo. The number of tiles in a complete set is normally 136.

Mah Jong is easy to learn, though in the beginning the rather complicated scoring system may seem
confusing. The element of luck is strong, as in all card games, but you’ll soon notice that having a good
memory and intuition is rewarding.

The rule variations of Mah Jong are endless. Four Winds lets you to customize many of the rules,
enabling you to change the nature of the game from a sheer game of fortune to an intellectual challenge
with an emphasis on strategic versatility. E.g., in addition to the modern European version, you can
choose Japanese or Hong Kong version of Mah Jong.
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@ Tiles

The traditional Mah Jong tile set consists of 136 tiles. The tiles are divided into two main groups: Suits
and Honors. These are further divided as follows:

Suit Tiles

There are three suits: Bamboos, Characters and Dots. Each suit consists of 36 tiles: four 1’s, four 2’s,

and so on up to 9. Total of suit tiles is thus 108.
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Dots

Suit tiles from 2 to 8 are called Simples, 1's and 9’s are called Terminals. Sets composed of Terminals pay
generally more than sets composed of Simples.

Honors

Honors consist of Dragons and Winds. There are three Dragons four of each: Green Dragon, Red
Dragon and White Dragon, and four Winds, four of each: East, South, West and North. Total of honor tiles
is thus 28.
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Winds

Letters on the Dragon tiles are based on the Chinese terms fa, chun, and pai pan.

Extra Tiles

In the popular Mah Jong the tile set is often extended by eight extra tiles: four Flowers and four
Seasons. These are not used in tile combinations: when received, they are immediately melded (exposed
and put aside) and replaced with a regular tile. Each extra tile is assigned to a wind as follows:

FEER

Flowers: Plum (East), Orchid (South), Chrysanthemum (West) and Bamboo (North).
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Seasons: Spring (East), Summer (South), Autumn (West) and Winter (North).

Tile identificators

When the game was introduced in the USA, numbers and letters were added on the tiles to make them
easier to recognize. You can hide the tile identificators, if you want to, by clearing the check mark from the
menu command Options Show Tile Id’s.
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@ The Deal

Traditionally the game starts with rather complicated preliminaries in order to determine the first dealer
(East) and the position of the first tile to be dealt from the Wall. Though the dealer is selected in Four
Winds simply by a random number generator, and the Wall is but an array of variables, the idea of this
ceremonial deal has been retained in the program by simulating it in algorithms.

After the player’s positions (i.e., their winds during the deal) have been determined and the Wall has been
built and broken, the deal starts.

Each player is dealt thirteen tiles, except the dealer, who receives fourteen tiles.

The tiles are dealt counter-clockwise in sets of four so that the dealer (East) gets the first four tiles, then
each of the other players receives four tiles in order South, West, and North. This is repeated three times.
Then the dealer gets two tiles (this is called chan-chan because of the clicking noise caused when picking
up the tiles), after which others are dealt one tile each.

If the Show Deal command is checked, the deal is animated. Otherwise the players’ dealt hands are
displayed immediately. If the Show Wall on Deal option is checked in the Preferences dialog box, you
can see how the Wall is broken at the start of the deal and how the tiles are taken from the Wall as they
are dealt to the players.

The Wall and the Dead Wall
wall
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After the deal has been completed, there are 83 tiles (or 91, if the Flower and Season tiles are in use) left
to play. Of these, 14 tiles are reserved as Supplement tiles that are used when a player needs an extra
tile after having declared a Kong, or after having received a Flower or a Season tile. These fourteen tiles
comprise the Dead Wall or Ruin, as it is sometimes called. The remaining 69 tiles (or 77, if the Flower and
Season tiles are in use) comprise the Wall.

Each time a tile is taken from the Dead Wall, the number of playable tiles in the Wall is reduced by one
(that is, one tile is moved from the Wall to the Dead Wall so that number of available supplement tiles is
always 14).

You can see the number or tiles that are left in the Wall in the Tiles Left Indicator located in the Status
Bar.

Replacing of the extra tiles

If the extended tile set is in use, all Flower and Season tiles received in the dealt hand are immediately
replaced with a supplement tile. This is repeated until all players’ hands consist only of regular tiles.
Replacing is done in the regular playing order (East, South, West, North) before the first move.
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@ Playing

Basics
. The goal of the game is to “go out® by completing a hand composed of four sets of three tiles

each, plus a pair, thus totaling fourteen tiles. A set may also be composed of four tiles, the total of
fourteen being increased by one for each such set.
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Example of a complete hand. The hand is composed of a Concealed Chow (Bamboo 1, 2, 3), a Concealed Pung
(Character 3), a Melded Chow (Dot 6, 7, 8), a Concealed PunE (Red QraTon) and a Pair of North Winds.
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Another example of a complete hand. This hand consists of three Concealed Pungs (composed of Character 3’s,
Dot 4’s and Dot 7’s), one Concealed Kong (Character 6), and a Pair of White Dragons. (Notice that a Concealed Kong must
be declared.)

" The sets are called as follows (click pictures to hear the Four Winds sounds attached to
each combination):
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Chow - a set composed of three sequential Suit tiles

Pung - a set composed of three similar tiles
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Kong — a set composed of four similar tiles

Note: A set that is composed only of tiles received from the Wall is called a concealed tile set. A
set that is composed by claiming one of the tiles from another player is called a melded tile set. A
concealed set scores more than a melded set.
The game is played counter-clockwise, that is, the players receive tiles from the Wall in the
following order: East, South, West, North. In Four Winds, the players are positioned on top of each other
and the playing order rotates from up to down.
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egular pace of the game
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Bl East (i.e., the dealer), who received 14 tiles on the deal, starts by discarding one of the tiles in his
hand. The discarded tile appears in East’s Discard slot on the right side of the game board.
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El  As the tile is discarded, other players have right to claim the tile to complete a set. E.g., if East
discards Bamboo 3, and West has two Bamboo 3’s in his hand, West can claim East’s discard in order to
compose a Pung (a set of three similar tiles). If you want to have the discarded tile, you must indicate
your claim bi clicking the discarded tile as long as it is visible in East’s Discard slot.

How to discard a tile

e

How to claim a tile

e
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There are certain rules that regulate player’s right to claim a tile for a Chow or Pair. For details,
Variations.
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Computer players make decisions regarding the value of claiming a tile according their player



characteristics. For more information, see Player type.
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Bl Players’ claims are evaluated after the Discard Delay specified in the Preferences dialog box. If
more than one player claims the same tile, the player having the most valuable claim gets the tile. Going
out with a discarded tile goes before any other option, and the remaining claims are evaluated in the
order Kong, Pung and Chow, first being the most valuable. If more than one player claim a discarded tile
for an equally valuable set (e.g., for a Chow), the player who is first in the playing order gets the tile.

e
=

Bl If a player gets a claimed tile, he must meld the tile set, that is, turn the tiles composing the
claimed set face-up and place them aside, above the hand tiles. After that, the player who claimed a tile
discards one of the remaining tiles in his hand. The next player in turn is the one sitting next to the player
who claimed the tile.
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Bl If none of the players claims a discarded tile, the tile is placed amongst the discarded tiles. After
at, the next plaier in turn gets a new tile from the Wall.
How to view discarded tiles

The cycle described here is repeated until one of the players succeeds to go out (i.e., to collect
r complete sets plus a pair), or until there are no more tiles left in the Wall.
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After the hand is played, the deal passes counter-clockwise to the next player. After each player
as been a dealer, the prevailing wind (or Wind of the Round) changes, and the next Round starts. The
game goes on until each of the winds has been a prevailing wind.
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=i A complete game of Mah Jong consists at least of 4 x 4 deals. Usually there are some extra
deals: e.g., if East wins, the deal does not pass, and in the popular Mah Jong, the deal does not pass
after a draw.
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Special cases

'—@ Declaring a Concealed Kong. If a player has three similar tiles in hand and he receives a fourth
similar tile from the Wall, he can declare a Concealed Kong. The tiles composing a Kong may also be
kept in hand to declare a Kong at a later time. When the set is declared as a Kong, the tiles composing
the set are turned face-up and placed above the hand tiles. After that the first and fourth tile in the set are
turned face-down, marking the combination as concealed.

Since a Kong consist of four tiles, and you must have four complete sets plus a pair in order to go
out, you receive one extra tile from the Dead Wall.

Note: A Kong must always be declared: if you are left with four similar tiles in hand when the deal
ends, you'll receive points (in case points are paid to losers) only for a Pung.
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Kong

How to declare a Kong
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e Declaring a Melded Kong. If a player has a Melded Pung and he receives a fourth similar tile
from the Wall, he can add the tile to the Pung and declare a Melded Kong.

Since a Kong consist of four tiles, and you must have four complete sets plus a pair in order to be
able to go out, you receive one extra tile from the Dead Wall.
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How to declare a Kong

" Robbing a Kong. A tile that is received from the Wall and used to complete a Melded Pung to a
Melded Kong, may be robbed by another player, if he needs it to complete his hand and go out. You can
have Four Winds notify you of this situation by checking the Hint on robbing a Kong option in the
Preferences dialog box.

How to rob a Kong

" Declaring ‘Ready’. If a rule of obligatory ready declaration is checked in the Preferences dialog




box, a player must inform other players that he is “ready”, i.e., that he needs only one tile to complete his

hand and go out. A player can’t declare ready and go out on the same turn. The names of players who
have made a readi declaration appear highlighted in the claim column.

How to declare ‘Ready’
. Going ‘Out’. If a player has four complete sets and a pair he may “go out®. The last tile needed to
complete the hand is received either from the Wall (or from the Dead Wall, as a supplement tile), or by
claiming another player’s discard.
After the declaration of out the hand is ended and the Points dialog box is displayed.

How to declare ‘Out’
" Hand ends in a Draw. If there are no tiles left in the Wall and none of the players has succeeded
to complete his hand, the deal ends in a Draw. In this case no points are paid and the next deal is started.
In the official rules the deal passes after a Draw, but you can specify otherwise in the Preferences dialog
box.

Note: If you use the Japanese rules, where only the winner receives points, you can specify in the
Preferences dialog box, that after a Draw, points are paid to players who have declared ready. For
details, see Scoring.
. Hand ends in a faulty declaration of Out. The deal ends, and the offender must pay the
amount of the limit points (usually 500 points) to the player who is East, and half the limit points to each of
the other players. If the offender is East, he must pay 500 points to each of the other players. After that
the deal passes and the next deal begins.




= Scoring

An important part of the skill of Mah Jong consists of knowing how different tile combinations receive
points. Though Four Winds does the most tedious job, the actual calculation, you should be aware of the
basic scoring rules.

The scoring of Mah Jong can get complicated. There are no universally accepted rules and many players
apply custom scoring. The scoring rules presented here are in accord with those of the Japanese Mah
Jong Association. Variations available in Four Winds are mentioned in parentheses and notes.

Scoring and payment rules of Hong Kong Mah Jong are very different from the traditional rules, so they
are described in detail in a separate help topic.

Tile points

The table below shows the points paid for the basic tile combinations. These points are calculated for all
players (provided that you have enabled the rules that allow paying to losers).

Tile set Melded Concealed
Chow none none
Pung of simples (suit tiles 2—8) 2 points 4 points
Pung of terminals (suit tiles 1 or 9) 4 points 8 points
Pung of dragons 4 points 8 points
Pung of winds 4 points 8 points
Kong of simples (suit tiles 2—38) 8 points 16 points
Kong of terminals (suit tiles 1 or 9) 16 points 32 points
Kong of dragons 16 points 32 points
Kong of winds 16 points 32 points
Pair of dragons* (2 points; if allowed) 2 points
Pair of prevailing player’s own wind* (2 points; if allowed) 2 points
Pair of prevailing wind* (2 points; if allowed) 2 points

* These are paid to losers only if enabled in the Preferences.

In addition to tile points, the winner receives points for:

Winning 20 points

Going out on a one-chance tile 2 points

Going out on a self-drawn tile 2 points

Concealed hand except for the last tile which was claimed 10 points
Doubles

After tile points are summed up, the doubles are calculated. The winner (and others, as well, if points are
paid to losers) receives doubles for the following tile sets and hands:

Tile set or combination Doubles
Pung or Kong of Dragons 1

Pung or Kong of player’s Own Wind 1

Pung or Kong of Prevailing Wind 1

Little Three Dragons 3

* Paid to losers only if enabled in the Preferences.

The winner receives following bonus points for special ways of going out:

Going out on a Supplement tile 1 double (or 10 points, depending on the rule)

Going out on the last tile of the Wall 1 double (or 10 points, depending on the rule)

Going out on the last discard (no tiles left in the Wall) 1 double (or 10 points, depending on the rule)

Going out on a robbed Kong 1 double (or 10 points, depending on the rule)
In addition, the winner receives doubles for the following hands:

Valueless Hand 1 (or 10 points, depending on the rule)

Hand with no Chows 1 (or 10 points, depending on the rule)

Hand with four Pungs or Kongs, three of which are concealed 2 (if acknowledged)



Hand with three Pungs or Kongs, all concealed
Concealed hand

Ready Hand declaration

One Suit Only

One Suit with Honors

All Simples

No Simples (that is, only Terminals and/or Honors)
Terminal or Honor in each set

Three consecutive sequences in one Suit

if acknowledged)
if acknowledged)
the rule of Riichi)
or 4, depending on the rule)

Py

if acknowledged
if acknowledged
if acknowledged

1
1
1
3
1
1
1
1
1 (if acknowledged

Py

)
)
)
)

The doubles are applied to the tile points. The following table helps to determine how the doubles are

paid:

Amount of doubles Tile points multiplied by

2

4

8
16
32
64
128
256
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Flowers and Seasons

Flowers and Seasons are not used in the official rules. If they are included in the game, all players receive

bonus points as follows:

Flower or Season 4 points each
Player’s own Flower or Season* 1 double

All Flowers* 3 doubles (or 2, depending on the rule)
All Seasons* 3 doubles (or 2, depending on the rule)

* Paid to losers only if enabled in the Preferences.

Note: The maximum number of doubles a player can receive for extra tiles is 6 (or 4, depending on the
rule), in which case the player has all Flowers and Seasons (that is, no additional doubles are paid for

player’s own Flower or Season).

Rounding

Notice that if rounding is enabled in the Preferences dialog box, the points are rounded off to nearest ten

before or after doubles.

Limit and Special hands

Certain hands automatically pay limit points, in which case the winner’s total points are determined by the
limit points setting specified in the Preferences dialog box. Notice however, that penalty points are added

to/reduced from the final paying points.

Acknowledged Limit and Special Hands vary according the rules. Total of variations is several dozens, but
the following ten limit and special hands are acknowledged by most versions of Mah Jong:

Limit or Special Hand Description

Thirteen Orphans One of each Dragon and Wind, 1 and 9 of each Suit and 14th tile forming a Pair with

any of these
Pung or Kong of each Wind, and any pair

Big Four Winds (Four Big Blessings)

Little Four Winds Pung or Kong of three Winds, a pair of the fourth, and any other set completing the
hand
All Honors Four Pungs or Kongs and a pair of Dragons or Winds

All Terminals (Heads and Tails)

Four Pungs or Kongs and a pair of 1’s or 9's

Big Three Dragons (Three Great Scholars) Pung or Kong with all three Dragons, any Chow, Pung or Kong, and any pair



Four Concealed Triplets (Hidden Treasure) Four Concealed Pungs, and any pair (may be claimed, if completes the hand)

Nine Gates Three 1's, a sequence of 2, 3, 4, 5, 6, 7, 8, and three 9’s, all of the same Suit, and
any other tile of the same Suit completing the hand

Heavenly Hand East declares ‘Out’ with the dealt hand (after Supplement tiles, if any)

Earthly Hand Non-dealer goes out on dealer’s first discard or self-drawn on first turn before any

Chows, Pungs or Kongs are declared

In addition to these 10, Four Winds recognizes the following ten common Limit or Special Hands:

Moon from the Bottom of the Sea Going out on the last tile of the Wall or on the last discard, tile being Dot 1.

Plum Blossom on the Roof Going out on a Supplement tile, tile being Dot 5

Scratching a Carrying Pole Going out on robbed Kong, tile being Bamboo 2

All Green g;oing out with sets composed only of Green Dragons, Bamboo 2’s, 3’s, 4’s, 6’s and
's

All Kong Hand containing any four Kongs, concealed or melded

Seven Pairs Hand containing any seven pairs. This hand pays 100 points, but can earn additional

points when combined with Honors and Terminals, or completed in one of the special
ways (e.g., on the last tile of the Wall).

Jade Dragon Pung of Green Dragon, three Pungs of Bamboo suit, and any pair.

Ruby Dragon Pung of Red Dragon, three Pungs of Character suit, and any pair.

Pearl Dragon Pung of White Dragon, three Pungs of Dot suit, and any pair.

Great Snake Consecutive Chows of the same suit, Pung or Kong of Winds or Dragons, and a pair

of Winds or Dragons.

You can select the Limit and Special hands you want to include in the game by creating or modifying a
custom rule preset and choosing the desired hands from a list box in the Limit & Special Hands dialog
box.

Payment

If Bonus for Dealer’s Extra Hands is checked in the Preferences dialog box, the bonuses are added to
winner’s totals at this point. For details, see Special cases below.

After the tile points and doubles have been calculated, the total is compared to limit points (specified in
the Preferences). If the total exceeds the limit, it is cut down to the specified limit (usually 500 points).

a) Points are paid to winner only

If the winning tile was received from the Wall, all players pay to the winner the amount of the winner’s
points. If the winner is the dealer (East), all players pay double the amount of the winner’s points.
Otherwise East only pays double, others pay normally.

Example
If the winner is East and he has 120 points, he will receive 240 points from all other players, total being 720 points. If the
Winner is West, he will receive 120 points each from South and North, and 240 points from East, total being 480 points.

If the winning tile was received by claiming another player’s discard, only the player who discarded the tile
pays to winner.

Example
If the winner is East and he has 120 points, he will receive 720 points from the player who discarded the tile. If the Winner is
West, he will receive 480 points from the player who discarded the tile.

b) Points are paid between all players

In this version of the game all losers pay the winner the amount of the winner’s points (except for East,
who pays double). In addition, the losers pay each other the amount that is the difference of their points.

Example

East wins. The players have points as follows: East 120, West 20, South 12 and North 0.

East receives 240 points from all losers, total being 720 points. The losers pay each other as follows: South pays 8 points to
West, North pays 20 points to West and 12 points to South.

Example
West wins. The players have points as follows: West 120, East 20, South 12 and North 0.



West receives 120 points from South and North and 240 points from East, total being 480 points. The losers pay each other as
follows: South pays 28 points to East, North pays 40 points to East and 12 points to South.

Penalties

If either of the following two penalties is enabled in the Preferences dialog box, the equivalent penalty
sums are reduced from players’ total points. The penalty sum does not vary according to player’s wind
(East does not have to pay double penalties).

There are two penalties with a fixed penalty sum (for other penalties, see the help topic Scoring
Variations- Penalties):

" Faulty claims: 100 points for each faulty declaration is reduced from offender’s total points. The
same amount is added to the winner’s total points. If the offender wins the hand, his personal penalties
are withdrawn.

. Ready penalties: 100 points are reduced from the total points of each loser who declared ready.
The winner receives these penalties, even if he has not declared ready. Notice that these penalties apply
only when points are paid to winner only and you have enabled the Rule of Riichi in the Preferences

dialog box.

Special cases

" Paying after a Draw. If enabled in the Preferences dialog box, a total of 600 points is dealt
among the players who have a Ready Hand, in case the hand ends in a Draw. The points are paid by
players who didn’t have a Ready Hand. Notice that players are not required to declare “Ready*.

Number of “ready“ players Points each player Total sum paid by each player not
having a Ready hand  having a Ready hand
receives
1 600 200
2 300 300
3 200 600
" Bonus for Dealers Extra Hands. If enabled in the Preferences dialog box, the losers must pay

bonus points to the dealer for his successive wins. When the dealer wins second time in a row, he
receives 300 points from other players (100 points per player). Three consecutive wins earns 600 points
(200 points per player), and so on, with an increment of hundred points per player for each successive
win. After the seventh successive win, the dealer receives the limit, after which the deal finally passes to
the next player. Notice that these points are added to winner’s total points after the doubles. In Hong
Kong Mah Jong, the amount of points grows in increments of 8 points (that is 3 * 8 = 24 points for the
second win, 3 * 16 = 48 points for the third, etc.).

Note: Bonus points for dealer’s extra hands are reported as penalties.



= Variations

The game of Mah Jong is very popular, especially in Asia, and it has hundreds of variations. Since Mah
Jong is often played for money, it is obvious that most variations deal with scoring, paying methods and
inclusion of Limit and Special Hands, but there are also some differences regarding such fundamental
components as number of tiles and acknowledging certain common hands.

The variations make the game richer, and greatly change its nature.

Four Winds lets you choose from several pre-defined rule presets. Though the more exotic variations are
left out, the current options cover the most usual versions, including the official Mah Jong as specified by
the Japanese Mah Jong Association, and the version of modern Mah Jong played in Europe.

In addition, Four Winds allows you fine-tune the rules to better suit your personal taste by offering several

customizable options. Different rule combinations can be saved as user-defined rule presets which can
later be chosen by just a couple of mouse clicks.

You can customize the rules and scoring in the Preferences dialog box.

Rule variations

Discarded tiles

The Rule of Ready
Flowers and Seasons

Pre-defined rule presets

Scoring variations

The scoring options of Four Winds offer variations of the classical scoring where the difference
between diverse options is small. Yet they provide enough flexibility to make the game an intellectual
challenge with an emphasis on careful discards and defensive strategies or a gambler’s playground
where one lucky strike makes you a millionaire, and another, less fortunate one, causes you bankrupt.

Paying method

Inclusion of double hands

Scoring of particular hands
Inclusion of Limit and Special hands
Penalty points

Hong Kong Mah Jong

Hong Kong Mah Jong is one of the most popular versions of Mah Jong played today, especially in
Asia. It differs from the modern European or Japanese Mah Jong mainly in terms of scoring, but some
important rule variations apply, as well. Four Winds implements Hong Kong rules as a pre-defined
preset, which you can customize in several ways.



= Rule variations — Chows

Chows are easy to collect and usually the player declaring out has at least one Chow in his hand. Very
often the hand consists of mere Chows, part of which are melded.

Because the Chows are so easy to collect, there are several rules, which regulate the use of Chows in
the game, thus making the game a bit friendlier for players who want to take risks by aiming at more
challenging hands.

a) Inclusion

Chows are very seldom excluded from the game, but by allowing a complete hand consist only of Pungs,
Kongs, and a pair, the game is made much more difficult. This makes it more plausible to aim at valuable
combinations, e.g. a hand consisting of only one Suit, etc. On the other hand, excluding Chows results in
deals that often end in a Draw.

To exclude Chows, clear the check mark from the Allow Chows check box in the Game tab of the
Preferences dialog box.

You can also limit the number of Chows allowed in the winning hand. To set the number of Chows from 1
to 4, use the Maximum # setting in the same tab.

b) Claiming

In the traditional Mah Jong a Chow can be claimed only from a player on the left of the claimer (that is,
from the previous player regarding the claimer’s position), except in situations, where the claimed tile can
be used to go out (in this case, the tile can normally be claimed from any player).

Some rules don’t regulate claiming of a tile for a Chow, in which case the claimer who sits closest to the
discarder (that is, the player whose turn comes first after the discarder) gets the discarded tile.

To set these rules, choose one of the radio buttons under the Allow Chows check box in the Game tab of
the Preferences dialog box.

If you want to restrict claiming of a Chow from any player to situations, where the discarded tile is used to
go out, select Only on Going Out check box in the Game tab of the Preferences dialog box.




= Rule variations — Pairs

Normally players are allowed to go out by claiming a tile for a pair. This greatly increases players’
possibilities to complete their hands. Novice players often get in a situation where they are left with a
single tile in their hand, desperately waiting for a missing tile from the Wall. If the missing tile can be
claimed from another players discard, there’s a good chance that a player still succeeds to complete his
hand.

To disable claiming of pairs, clear the Allow Claiming Pair on Going Out option in the Game tab of the
Preferences dialog box.




= Rule variations — Discarded tiles

In the Japanese Mah Jong, where an unwise discard may result in severe losses, the meaning of
discarded tiles is very important.

The rule of Sacred Discard, that is used by default in the Riichi Mah Jong, forbids a player to claim a tile
that is identical to his last discard. The rule can also be applied to entire deal. In this case the players
must be utmost careful when they consider their discards.

To enable the rule of Sacred Discard, check Apply Sacred Discard in the Game tab of the Preferences
dialog box. To extend the rule, check During the Entire Deal.

The rule of Missed Discard forbids a player to complete his hand and go out by claiming a tile that he has
missed during the current turn (that is, after his last discard and before he has received a new tile from
the Wall). This allows other players some safety regarding their choice of discard. Notice however, that if
Chows can be claimed only from the player on the left (including the situation where the tile can be used
to go out), there is no guarantee that discarding similar tiles is safe! Notice also, that it is legal to claim a
missed discard if the player does not declare ‘Out’ immediately after the claiming.

To apply the rule of Missed Discard, check Apply Missed Discard in the Game tab of the Preferences
dialog box. -



= Rule variations — The rule of Ready

a) Obligatory Ready declaration

In the popular Mah Jong, the players are often required to declare that they need only one tile to complete
the hand and go out. This causes other players to be more careful in their choice of discards, especially if
the rules dictate that the discarder of the winning tile alone pays all winnings.

A ready declaration is likely to cause changes in other players’ decisions, and it could well be used for
strategic purposes. E.g., if a player gets poor tiles on deal, it may be a good idea to fool other players by
declaring ready early in the game: in this situation a player who has been lucky on the deal and is aiming
at an exceptionally valuable combination may well re-consider his plans and try to go out as soon as
possible with a hand that causes only modest losses to other players.

The rule of the obligatory ready declaration also adds a sort of “blunder” element to the game. You may
get in a situation, where you notice that you have a complete hand but you have forgotten to make a
ready declaration because of being too eager to collect the sets. The only way out of this situation is to
make a ready declaration and give away one of your precious tiles!

Tip: If you check the Scatterbrain option for computer players, it is possible that they do the same
mistake. The option can be set in the Players tab of the Preferences dialog box.

b) The Rule of Riichi

In the Riichi Mah Jong the rule of Ready Hand is very different. First of all, the rule requires that the hand
to be declared ready is completely concealed. In addition, the rule requires that

. Each player who declares a Ready Hand must pay 100 points; the player who wins the hand will
receive these points after the hand is ended (even if the winner has not made a ready declaration).

" After the declaration the hand is locked and the tiles are turned face-down. That means that the
player can’t change his plans: the only thing to do is to wait for the tile that completes the locked hand.

. A player must go out on the first tile that allows him to do so. E.g., if there are more than one
possibilities, a player is not allowed to wait for a better tile. If you miss a tile (either from the Wall or a tile
discarded by another player) that you could have used to complete your hand, Four Winds automatically
cancels your declaration of Ready, makes the hand visible again and unlocks the tiles. The hundred
points you paid for the declaration is added to your penalty points.

These restrictions make it unlikely that a player would declare ready without really having a ready hand.
Furthermore, the price for this effort is rather small: if the player who has made a ready declaration wins,
he’ll receive one extra double (plus the points paid for ready declarations).

Tip: If you apply the Rule of Riichi, you may want to check the Pay for Ready Hands After Draw option
in the Points | tab of the Preferences dialog box. If the hand ends in a Draw, you'll receive at least 200
points for a good effort.

To enable one of the Ready Hand rules, first check the Apply Ready Hand Rule check box in the Game
tab of the Preferences dialog box, then select one of the radio buttons under the option group.




= Rule variations — Flowers and Seasons

In the popular Mah Jong the standard set of 136 tiles is often extended by 8 extra tiles — 4 Flowers and 4
Seasons — which make the element of luck more prominent in the game. The extra tiles are not used in
sets. They are put aside and replaced immediately after they are received with a regular tile.

Each extra tile earns 4 bonus points and player’s own Flower or Season gives one extra double. All
Flowers or all Seasons pays 3 doubles (or 2, depending on the rule) so that the maximum number of
doubles for extra tiles can be 6.

To extend the tile set with Flowers and Seasons, check Use Extended Tiles in the Game tab of the
Preferences dialog box.




» Rule variations — Pre-defined rule presets

Four Winds comes with eight pre-defined rule presets which you can easily select by using the Rule
Presets drop-down list box in the General tab of the Preferences dialog box.

The rule presets and their descriptions are in the table below (only some of the rule options are
mentioned in the table).

Rule preset Tiles Claim Claim Sacr. Missed Rule of Deal Initial  Limit Paying Limit
Chows Pair Disc. Disc. Ready Passes Points Points hands
on Draw
Sheer Luck 144 All Yes - - - - 8000 2000 All 20
Novice 136 Allon Out  Yes - - Req. - 2000 500 All -
American Classical 144 Allon Out  Yes - - - - 4000 1000 All 14
European 136 Allon Out  Yes - - - - 2000 500 All 9
Contemporary
Japanese Official 136 Allon Out  Yes Yes - - Yes 2000 500 Winner 10
Japanese Riichi 136 Allon Out  Yes Yes - Riichi Yes 8000 1500 Winner 10
Four Winds 136 Left Only - - Yes - - 2000 500 All 20
Hong Kong 144 Allon Out  Yes - - - - 2000 128 Winner 6

The default preset is European Contemporary. You can easily create custom rule preset by using any of
the pre-defined presets as a template. For more information about creating a custom rule preset, see

Creating and managing custom rule preset.

Extra
doubles
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N
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» Scoring variations — Paying method

a) Points are paid to the winner only

In the official Mah Jong points are paid only to the winner. In addition, if the winner goes out on another
player’s discard, the discarder is alone responsible for paying the winning points. This puts emphasis on a
need to go out as early as possible. There is no reward for an ambitious effort if you lose.

The official rule also emphasizes the importance of careful discards. It is often advantageous, especially
in the end of the deal, to sacrifice a “good” tile if you can be sure that it can be safely put away.

Since the official rules acknowledge several additional double hands (e.g., “All Terminals and Honors",
“Terminal or Honor in Each Set®, etc.), the points can get fairly high. In addition, the differences between
players tend to be bigger, because one unlucky discard may cost a player several hundreds, even
thousands of points.

To choose the official paying method, select the To Winner Only by Discarder/All Losers radio button in
the Points | tab of the Preferences dialog box.

b) All pay to the winner and points are settled among losers

In the popular Mah Jong the winner is always paid by all the losers. In addition, losers pay each other
according the difference of their scores. It may well be that a loser — if he has an excellent hand — gains
more points than a winner. If you like to collect limit hands or aesthetically appealing tile combinations,
this is your version of the game!

In this version of the game it is safer to aim at value hands every now and then. Since all players are
equally responsible for paying to the winner, the differences between the players tend to be small.

To choose the popular paying method, select the Between All Players radio button in the Points | tab of
the Preferences dialog box.




» Scoring variations — Inclusion of double hands

Most of the hands scoring doubles are universally acknowledged. The most usual exceptions are those
acknowledged in the official Japanese Mah Jong: in most other versions they are not acknowledged, at
all. Some of these hands have been included in Four Winds as options, which you can enable or disable
individually. The hands are as follows:

Hand Doubles (in Hong
Kong version, points)

Concealed Hand

All Simples

Terminal or Honor in each set

Four Triplets, 3 concealed

Three Triplets, all concealed

1 through 9 of one Suit

All Terminals and Honors

A A AN 2 A A

To choose the hands you wish to include in the game, click the Acknowledged Hands radio button in the
Points Il tab of the Preferences dialog box. Include or exclude single hands by double clicking the items
in the list box.




= Scoring variations — Scoring of particular hands

Certain hands are almost universally acknowledged by all versions of Mah Jong, but they are often
scored slightly differently. Scoring options of some of these hands have been included in Four Winds.
(Notice that in Hong Kong version you can’t change the values.) The hands are as follows:

Hand Options Hong Kong Mah Jong

Special ways of going out 1 double/10 points 1 point each

- on a Supplement tile
- on the last tile of the Wall

- on the last discard (no tiles left in the Wall)
- on a robbed Kong

Valueless Hand (4 Chows) 1 double/10 points 1 point

No Chows 1 double/10 points 3 points
One Suit Only 4 doubles/3 doubles 6 points
All Flowers or All Seasons 3 doubles/2 doubles 3 points

To choose the scoring options for single hands, click the Bonus & Double radio button in the Points Il
tab of the Preferences dialog box. Change the scoring options by double clicking the items in the list box.




» Scoring variations — Inclusion of the Limit and Special Hands

Most versions of Mah Jong acknowledge at least ten limit or special hands. Some rules exclude limit and
special hands altogether, and in some rules the number of acknowledged Limit and Special Hands (with
more or less imaginative and forgettable names) may be several dozens.

Four Winds recognizes 20 different Limit and Special Hands. All except two (Thirteen Orphans and Seven
Pairs) consist of regular tile sets so it is unlikely that you miss a valuable combination if you succeed to
get one. For more information about the Limit and Special Hands, see Scoring.

To enable the Limit and Special Hands, check Allow Special hands in the Points | tab of the
Preferences dialog box. To define the special and limit hands to be included in the game, first create or
choose a customized rule preset, then click the Select button in the Points | tab. This displays the Limit
and Special Hands dialog box.




» Scoring variations — Penalties

There are several penalties that different Mah Jong versions apply to offenses and mistakes players can
make during the game. Some deal with blunders like faulty declarations or having too many tiles in hand.
Others deal with punishments for bad playing, e.g. giving away a valuable winning tile gratuitously.

In the current version of Four Winds, the following five penalties can be applied:

. Faulty declaration of ‘Out’: The deal ends, and the offender must pay the amount of the limit
points (usually 500 points) to the player who is East, and half the limit points to each of the other players.
If the offender is East, he must pay 500 points to each of the other players. After that the deal passes and
the next deal begins.

. Faulty claims: 100 points for each faulty declaration are reduced from the offender’s total points.
The same amount is added to the winner’s total points. If the offender wins the hand, his personal
penalties are withdrawn. This penalty can’t be chosen when playing according the Hong Kong rules.

" Five last tiles error. If there are five or less tiles left in the Wall, and the player discards a tile that
has not been played already (i.e., that is not visible on the board or amongst the discarded tiles), and
another player claims the tile and goes out, the discarder must pay to winner on behalf of the other
players. Notice that this penalty is meaningless (and can’t be chosen), if you have applied a rule
according to which discarder always pays for all players.

. Nine tiles error. This penalty is applied, if one of the players (e.g., player A) has three (or four)
melded Pungs or Kongs of the same suit, and another player (B) discards a tile of the same suit. If the
discarded tile is claimed by player A, and he goes out and the winning hand is All One Suit, the discarder
(B) must pay to winner on behalf of other players. Notice that the penalty applies even if the player claims
the tile and composes a fourth set of the same suit, provided that he subsequently goes out on a self-
drawn tile, and the winning hand is All One Suit. However, if a third player (C) also discards a tile of the
same suit, and player A claims the tile and goes ‘Out’, the penalty is applied to player C.

" Ready penalties: 100 points are reduced from the total points of each loser who declared ready.
The winner receives these penalties, even if he has not declared ready. Notice that these penalties apply
only when points are paid to the winner only and you have enabled the Rule of Riichi in the Preferences
dialog box. Notice that you can’t disable these penalties.

To enable or disable the penalties, check or uncheck the appropriate option in the Points Il tab of the
Preferences dialog box.




= Hong Kong Mah Jong

The Hong Kong version of Mah Jong is basically the same as the modern European or Japanese version
of Mah Jong. The main differences are in scoring, which is greatly simplified.

Basic rules and main differences

" Pungs and Kongs score the same. The only reason for declaring a Kong instead of a Pung is
that the player does not want to discard any of the tiles in his hand.

" East does not pay or receive double. This rule is unique to Hong Kong Mah Jong. Notice
however that if the winner goes out on a self-drawn tile, each player pays double the amount of winner’s
pay points.

. Points are paid only to the winner. As in the Japanese rules, points are paid only to the winner.
But unlike the Japanese rules, the discarder normally does not pay for other players (but you can apply
this rule, if you want to).

" If the winning tile is self-drawn, all losers pay double. Otherwise the discarder pays
double, and others pay normally. This rule emphasizes the meaning of having the winning tile from the
Wall. Also, since discarding a tile is not punished as severely as in the Japanese version of Mah Jong, the
players can collect high scoring hands more aggressively.

" Flowers and Seasons. In addition to regular extra points (for player’s own Season or Flower),
additional points are given for the Flower or Season of the prevailing Wind. In addition, one point is given
for not having any Flower or Season tile.

" The amount of Limit points is 128. The limit in other versions is normally higher, but the
payments are generally smaller in the Hong Kong version of Mah Jong. The limit can’t be changed in the
Hong Kong version.

. The deal does not pass after a Draw (or after East’s win). This is the same as in the American
and European version. Notice that in the Japanese version the deal passes after a Draw.

Scoring

There are significantly less scoring combinations than in other versions of Mah Jong. You can
customize the rules by acknowledging additional hands.

Points for tiles and ways of going out

Four Chows A hand composed of mere Chows and a pair. 1 point
Four Pungs/Kongs A hand composed of mere Pungs and/or Kongs and a pair. 3 points
Self-drawn The winning tile is taken from the Wall 1 point
Winning on a The winning tile is received from the Dead Wall (as a replacement for a 1 point
Supplement tile Flower or a Season, or for a tile used in composing a Kong).

Winning on the last tile  The winning tile is the last tile available in the Wall. 1 point
of the Wall

Winning on the last The winning tile is the last discard played in the game after no more tiles are 1 point
discard available in the Wall.

Winning by robbing a The winning tile is taken from a player completing a melded Pung to a Kong. 1 point
Kong

Pung/Kong of Dragons  E.g., a Pung of Red Dragons. 1 point
Pung/Kong of Own E.g., South having a Pung of South Winds. 1 point
Wind

Pung/Kong of the Wind  E.g., North having a Pung of East Winds, when East is the prevailing wind. 1 point
of the Round

One Suit with Honors E.g., three Chows of the Bamboo suit, Pung of Dragons, and a pair of Winds. 3 points
One Suit Only All sets are composed of Bamboo, Character or Dot tiles. 6 points
Big Three Dragons A hand consisting of three Pungs/Kongs of each Dragon (Green, Red and 6 points

White), and any Chow/Pung/Kong, and a pair, completing the hand. Notice
that this is normally a Limit hand.

Little Three Dragons A hand consisting of two Pungs/Kongs of two Dragons (e.g. Green and Red), 4 points
and a pair of the third Dragon, and any other sets completing the hand.
All Honors A hand consisting solely of Wind and Dragon tiles. Notice that this is 7 points

normally a Limit hand-
Own Flower or Season  E.g., East having the Summer tile. 1 point



Flower or Season of the E.g., North having the Summer tile, when the prevailing wind is East. Thisis 1 point
Wind of the Round unique to Hong Kong version.

All Flowers or Seasons  Player has all four Flowers or Seasons. If the player has all Flowers and 3 points
Seasons, he receives 6 points (i.e., points for own Flower and Season, and
for Flowers or Seasons of the prevailing wind, plus two extra points).

No Flowers or Seasons The player has not received any Flowers or Seasons during the hand. This is 1 point
unique to Hong Kong version.

Limit and Special Hands

Only six Limit and Special Hands are acknowledged in the pre-defined preset. You can include more,
if you want to. Some of the hands pay a fixed amount of points, others pay automatically the limit (128
points). Notice that Big Three Dragons and All Honors (see table above) are listed in the Limit &
Special hands dialog box, though they pay a fixed amount of points.

Seven Pairs A hand composed of any seven pairs. Notice that this hand can give 4 points
additional points if composed of Honor tiles or merely one Suit, or completed
in some of the above mentioned special ways.

Thirteen Orphans One of each Dragon and Wind, 1 and 9 of each Suit and 14th tile forming a Limit
Pair with any of these.

Nine Gates Three 1's, a sequence of 2, 3, 4, 5, 6, 7, 8, and three 9’s, all of the same Limit
Suit, and any other tile of the same Suit completing the hand

Jade Dragon Pung of Green Dragon, three Pungs of Bamboo suit, and any pair. Limit

Ruby Dragon Pung of Red Dragon, three Pungs of Character suit, and any pair. Limit

Pearl Dragon Pung of White Dragon, three Pungs of Dot suit, and any pair. Limit

Payments

The tile points are simply added, after which the paying points are determined. There are no doubles
in the Hong Kong version of Mah Jong.

The paying points are calculated as follows:

Points  Discarded Self-drawn
0 1+1+2=4 -
1 2+2+4=8 4+4+4=12
2 4+4+8=16 8+8+8=24
3 8+8+16=32 16+16+16=48
4-6 16+16+32=64 32+32+32=96
7-9 32+32+64=128 64+64+64=192
10- 64+64+128=256 128+128+128=384
" Hands have names after how they score. A mixed hand that is completed on a discarded tile

and that consists of Chows and ordinary Pungs/Kongs is called a Chicken hand and gives no points (but
pays 4 points). A hand worth 4, 5 or 6 points is called Full House, a hand worth 7, 8 or 9 points is called
Double Full House, and a hand worth 10 or more points is called Triple Full House, and pays the limit.

" Discarder pays double, others pay normally. Notice the difference from the Japanese rules,
where discarder pays on behalf of the other players, as well. You can change this rule so that the
discarder pays for all players.

" Winning on a self-drawn tile pays more. Notice the difference from other versions of Mah Jong.
Normally the winner is paid the same sum whether he has gone out on a discard or self-drawn.

Penalties

The following three penalties can be applied:
" Faulty declaration of ‘Out’. The deal ends, and the offender forfeits a penalty that is the amount
of the limit points (128 points), which is paid to each player, totaling in a loss of 384 points.
" Five last tiles error. If there are five or less tiles left in the Wall, and the player discards a tile that
has not been played already (i.e., that is not visible on the board or amongst the discarded tiles), and



another player claims the tile and goes out, the discarder must pay to winner on behalf of other players.
Notice that this penalty is meaningless (and can’t be chosen), if you have applied a rule according to
which discarder always pays for all players.

" Nine tiles error. This penalty is applied, if one of the players (e.g., player A) has three (or four)
melded Pungs or Kongs of the same suit, and another player (B) discards a tile of the same suit. If the
discarded tile is claimed by player A, and he goes out and the winning hand is All One Suit, the discarder
(B) must pay to winner on behalf of other players. Notice that the penalty applies even if the player claims
the tile and composes a fourth set of the same suit, provided that he subsequently goes out on a self-
drawn tile, and the winning hand is All One Suit. However, if a third player (C) also discards a tile of the
same suit, and player A claims the tile and goes ‘Out’, the penalty is applied to player C.

Note: Penalties for faulty claims are not used in Hong Kong Mah Jong.



= Keyboard shortcuts

Key

F1

F2

F3
CTRL+Q
CTRL+O
CTRL+S

R or CTRL+R
(Note: ALT+R does not work)

K
(Note: ALT+K does not work)

(o]
(Note. ALT+O does not
work)

D

w

L

H
SPACEBAR

ENTER

HOME

END

UP ARROW
DOWN ARROW
LEFT ARROW

RIGHT ARROW

+ KEY (NUM PAD)
- KEY (NUMPAD)
ALT+F4

Action

Help contents
New game
Pause (toggle)
Abort game
Open game
Save game

Declare Ready

Declare Kong/Rob Kong

Declare ‘Out’

Show Discards/Show Hands

Show Wall (toggle)

Lock discards of other players(toggle)
Suggest a tile to be discarded

Discard/Undo discard/Claim (when it's not player’s
turn)

Accelerate (bypass delay)

Lift the first hand tile

Lift the last hand tile

Lift the first hand tile (when none of the tiles is raised)
Lower a raised tile

Lift a tile on the left of the currently raised tile
Lift the first hand tile (when none of the tiles is raised)

Lift a tile on the right of the currently raised tile
Lift the first hand tile (when none of the tiles is raised)

Increase volume of backgound music
Decrease volume of background music

Close Four Winds

Alternative

Help Contents
Game New Game
Game Pause
Game Abort

File Open

File Save

Click the Ready button (if visible), or choose Game
Declare Ready Hand

Click the Kong button/Rob Kong button

Click the Out button

Click the Discards/Hands button
Options Show Wall

Options Lock discards

Game Hint

Right click a lifted tile or anywhere above your hand
row/To undo your discard, click on a tile in your
Discard slot/Click on a tile in the discarder’s Discard
slot

Click anywhere on the game board
Click on the first tile in the hand
Click on the last tile in the hand
Click on the first tile in the hand
Click on a lifted tile

Click on a tile on the left of the currently lifted tile
Click on the first tile in the hand

Click on a tile on the right of the currently lifted tile
Click on the first tile in the hand

None
None

Click the Close button, double click the Control Box,
click on Control Box and select Close, or choose
File Exit

In addition, you can use standard methods like pressing accelerator keys in dialog boxes. E.g., pressing
W, or ALT + W, would check or uncheck an option labeled Show Wall).



» Glossary
Chow

Claim
Concealed
Dead Wall
Dealer

Discard slot
Draw

Game

Going ‘out’
Hand

Honors

Kong

Limit hand
Limit points
Little Three Dragons
Meld

Melded

Missed Discard

One-chance
Passing of the deal

Prevailing wind
Pung
Ready hand

Robbed Kong
Round

Sacred Discard
Self-drawn

Set

Simples
Special hand
Suit tile
Supplement tile
Terminals

Wall

Valueless hand
Wind of the Round




= Screen
Click on the bitmap to get help on different areas of the screen.
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» Game Board
Click on the bitmap to get help on different areas of the game board.
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= Claim Column

The Claim column consists of four identical areas, one for each player. Click on the bitmap to get help on
different areas of the area.
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= Title Bar and Menus

Click on the bitmap to get help on the title bar and menu items.
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= Status Bar
Click on the bitmap to get help on different areas of the Status bar.
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Discards Button

Click Discards to display the discarded tiles. As you click the button its caption changes to read Hands. Click Hands
to re-display the hands.

You can change between the Discards and Hands View also by pressing D repeatedly. Notice that if you have locked
other players’ discards on the screen by using the Lock discards command under the Options menu, the
Discards/Hands button only has effect on the visibility of your own tiles.



Tiles Left Indicator
Shows the number of tiles left in the Wall.



Wind of the Round

Shows the Wind of the Round. The prevailing Wind, or Round, changes after each player has been a dealer (East). A
complete Mah Jong game consists of four complete Rounds.



Hand

Shows the number of the hand and the number of re-deals (if applicable) on the current Round. Each Round consists
of at least four hands since each player must have acted as a dealer (East) at least once during the Round. In certain
cases extra hands, or re-deals, are played. E.g., if the dealer goes out, an extra hand is played, in which case the
deal doesn'’t pass. In the popular Mah Jong, it is common that the deal doesn’t pass if the hand ends in a Draw (i.e., if
no one goes out).



Hand Counter

Shows the total number of hands played in the game.



Kong Button
Click Kong to declare a Concealed or a Melded Kong. The button is enabled only on your turn.

Four Winds checks that your declaration is valid. If it is, the Kong dialog box is displayed. If you have more than one
options, you can choose which of the combinations you wish to declare as a Kong. You can also cancel the
declaration.

If your declaration is illegal, a message box is displayed informing you of this.

Note: In a situation where you have a chance to rob a Kong, the caption of the Kong command button changes to
read ‘Rob Kong’. You can force Four Winds to notify you of this situation by choosing the Hint on robbing a Kong
check box in the Preferences dialog box. For more information about robbing a Kong, see Robbing a Kong.




Out Button
Click Out to ‘go out’, that is, to declare that you have a complete hand.

Four Winds checks that your declaration is valid. If it is, the hand ends and the Points dialog box is displayed. If you
make an illegal declaration, the hand ends, and a message box appears informing you of this situation. If penalty
points for faulty declaration of ‘Out’ are enabled, the Points dialog box is displayed, informing you of your losses.

Note: If the rule of obligatory Ready Hand rule is applied, the caption of the Out command button reads at first
‘Ready’. After you have clicked Ready the caption changes to read ‘Out’.



Message Line

Message Line displays information about the game and currently selected objects. The hints are displayed on the
Message Line, as well.

If you have checked the Show Messages command option in the Options menu, most of the game messages are
displayed in a message box, instead.



Control Menu Box
Click to access the standard Windows Control Menu, where you can minimize and reposition the window and close
the program.

You can close Four Winds by double clicking the Control Menu Box.



Window Title

Displays the name of the application and the name and path of the currently open game file.



Minimize Button
Click to minimize Four Winds to the Taskbar. To restore the Four Winds window, click on its icon in the Taskbar.

Note: The game is paused while the Four Winds window is minimized, and resumes automatically as the window is
restored.



Close Button

Click to close Four Winds. Warns if you’re about to lose changes to the on-going game.



Menu Bar

Menu Bar lists the available menus. Click on menus below to get help on different menu items.



Hand Tiles Row

Area for a computer player’s hand (similar for all three computer players). The tiles on the Hand Tiles Row are placed
face-down so that you can’t see what kind of combinations a player collects.



Human Player’s Hand Tiles Row
Area for the human player’s hand. The tiles on the human player’s row are placed face-up.

Note: If the player has declared ‘Ready’ according to the Japanese Ready Hand rule, the tiles are turned face-down
and locked. Only the new tiles from the Wall are received face-up.



Melded Tiles Row

Area for a computer player’s melded sets (similar for all three computer players). The tiles on the Melded Tiles Row
are placed face-up so that you can see them and try to figure out what kind of tiles the other players are collecting.

Note: Concealed Kongs are marked by turning the first and fourth tile of the set face down.



Human Player’s Melded Tiles Row

Area for the human player’s melded set.



Extra Tiles Area

The Flower and Season Tiles a computer player receives are placed face-up on this area (similar for all three
computer players).



Human Player’s Extra Tile Area

The Flower and Season Tiles the human player receives are placed face-up on this area.



Player’s Total Score

Player’s Total Score in the game.



Player’s Name
Player’'s name. The names can be changed from the Preferences dialog box.

Note: If the Ready Hand rule is applied and a player declares ready, the color of his name appearing on the Claim
Column changes.



Discard Slot and Player’s Wind

A slot where the player’s last discard is placed for viewing. As long as the tile is visible, the discarded tile can be
claimed by other players. The Discard Delay can be set in the Preferences dialog box.

A kanji symbol and the equivalent Latin character (E, S, W, N) shows the player’s wind during the current deal. Dealer
is always East. At the end of the hand, the deal passes to the right so that the player who was South (i.e., player who

“sits on the right* of the player who was East) becomes East, one who was West becomes South, one who was North
becomes West, and one who was East becomes North.



Human Player’s Discard Slot and Wind

A slot where the human player’s last discard is placed for viewing. If Undo is enabled, the discarded tile can be drawn
back by clicking on it (or by pressing the SPACEBAR). Undo can be enabled or disabled in the Preferences dialog
box.

A kanji symbol and the equivalent Latin character (E, S, W, N) shows the human player’s wind during the current
deal.



Sound of Chow

Sound of Chow is heard whenever a player claims a discarded tile for a Chow. {mci PLAY
NOPLAYBAR,CHOW.WAV}



Sound of Pung

Sound of Pung is heard whenever a player claims a discarded tile for a Pung. {mci PLAY
NOPLAYBAR,PUNG.WAV}



Sound of Kong

Sound of Kong is heard whenever a player claims a discarded tile for a Kong, or declares a Concealed or Melded
Kong. {mci PLAY NOPLAYBAR,KONG.WAV}



Player’s name

Each player’s name, and the first letter of player’s current wind (E, S, N, W), appear at four sides of the Wall.



Player’s wind

Each player’s wind is indicated by a bone tile with a kanji symbol representing player’s current wind. In addition, the
first letter of player’s wind (E, S, W, N) appears after his name.



East wind

East wind is represented by a red kanji symbol. In addition, the letter “E" appears after the player’s name.



Wind of the Round

Wind of the Round, or the Prevailing Wind, is depicted using the equivalent kanji symbol placed in the frame in the
middle of the Wall window.



Wall tiles

Initially the Wall consists of four double rows of tiles arranged in a square-like shape. The new tiles are taken from the
open end of the Wall. When there are no tiles left in the Wall, and no one has succeeded to go out, the hand ends in
a Draw.



Dead Wall
The Dead Wall, or the Ruin, consists of 14 tiles. In Four Winds the tiles of the Dead Wall can be discerned by their

gray back color. Tiles from the Dead Wall are used, when a player needs a Supplement tile after declaring a Kong or
after receiving a Flower or a Season tile. A tile taken from the Dead Wall is immediately replaced by a Wall tile so that

the total number of tiles in the Dead Wall is always fourteen.



Close button

Click to close the Wall window, or press W. To re-display the window, choose Show Wall from the Options menu, or
press W again. The Wall appears at its previous position (or centered, when activated at first time).



File Open

Opens the Open Game dialog box where you can choose a Four Winds game (files with .4W extension) you wish to
load. You can open a game only when it is your turn.

When you load a game, and you're in the middle of another game, the program warns you about losing of the
changes, and lets you save the previous game before opening another one.

Hint: You can tell Four Winds to automatically open the last saved game on program start-up by checking the Open
last saved game on start-up check box. Notice that this works only if you close the program right after having saved
the game.

Note: As an alternative for the command File, Open, you can open a saved game (along with Four Winds, if it is not
already running) by double clicking a game file (a file with .4W extension) in the Windows Explorer. You can open a
.4W file also by dragging it from the Windows Explorer and dropping it onto Four Winds main window.

Shortcut: CTRL+O



File Save

Saves the currently on-going saved game. You can save a game only on your turn.

If you want to save a game under a different name, use the Save As command, instead.
Shortcut: CTRL+S



File Save As

You can save the on-going game whenever it's your turn. The command opens the Save Game As dialog box where
you can enter the location and file name for the new game. This information is displayed on the Title Bar, as well.
You can also give a short description (max. 128 characters), that is displayed when you open a saved game.

After saving a new game, you can quick save the game during your play turn easily by using the Save command.

If you want to save the games to a folder other than Games (the default folder), just choose the folder you wish in the
Save As dialog box (or create a new folder). Four Winds asks you whether this folder is made the new default folder
for saved games.

You can also use the Save As command to rename an on-going saved game.

Hint: You can tell Four Winds to automatically open the last saved game on program start-up by checking the Open
last saved game on start-up check box. Notice that this works only if you close the program right after having saved
the game.



File Display Rules
Opens the Rules dialog box, where you can quickly see the rules that are currently in effect.



File Display Points

Opens the Points dialog box, where you can browse the points and scores of all the hands played in the game. You
can also print point reports from the Points dialog box.



File Preferences

Opens the Preferences dialog box, which allows you to choose the game rules and player characteristics, and
change general options, like the speed of the animation. You can also choose another theme for the game (including

tiles, game board graphics, sounds and cursors), and customize the sounds.




File Exit
Exits Four Winds. Warns if you’re about to lose changes to an on-going game.
Shortcut: ALT+F4



Game New Game

Mixes the tiles and starts a new game. As you have started a game, you can quit the game by choosing Abort from
the File Menu (shortcut CTRL+Q).

You can’t change the game rules or player characteristics, nor the theme, after a game is started.
Shortcut: F2



Game Abort Game

Quits the on-going game and clears the game board. If you're in the middle of an existing game and are about to lose
the changes, a dialog box warning you about this situation is displayed with options to save the changes (if it is
currently your turn), accept the abort command without saving the changes, or cancel the command.

Shortcut: CTRL+Q



Game Undo

Lets you cancel your discard immediately after you have completed your turn.

You can draw back your discard also by clicking on the tile before it fades out or someone else has claimed it.
Note: You can disable this feature in the Preferences dialog box.

Shortcut: SPACEBAR (or CTRL+Z)




Game Restart Hand
Lets you restart the current hand.

Note: You can disable this feature in the Preferences dialog box.




Game Hint

Gives a hint on tile to be discarded. The quality of the suggestion is determined by the player setting in the Player tab
of the Preferences dialog box.

Note: You can disable this feature in the Preferences dialog box.

Shortcut: H




Game Declare Ready Hand

Lets you declare a Ready Hand. The command is visible only if you have enabled one of the Ready Hand Rules in
the Preferences dialog box.

Note: If a declaration of ‘Ready’ is obligatory, you can declare Ready Hand also by pressing Ready in the Status
Bar. After the declaration, the caption of the button changes to read ‘Out’.

Shortcut: CTRL+R




Options Pause

Pauses the game. Resume the game by choosing the command again.
Note: The command is disabled on your turn.

Shortcut: F3



Options Show Deal
Enables or disables animated deal.

Note: You can always bypass the deal animation while it is displayed by clicking anywhere on the game board.



Options Show Tiles
Displays or hides the tiles of other players.

Displaying tiles is useful when you’re learning the game and want to examine the game strategy of your opponents.



Options Show Wall
Displays or hides the Wall window.

Shows the progress of the current deal in real time. The Wall window is automatically displayed whenever a new deal
starts. You can disable this feature in the Preferences dialog box.

Shortcut: W




Options Show Tile Id’s

Displays or hides the alphanumeric tile identificators.



Options Show Messages

Enables or disables displaying of messages (e.g., claims of other players) in a message box. By default the
messages are displayed in a message box. Disabling this command shows most of the messages in the message
line, instead.

Showing the messages in a message box may be a good idea when you’re learning the game, as it gives you more
time to see what's going on. But as soon as you have learnt the basics, you might want to turn off this feature, since it
affects the pace of the game. Notice that you can influence the pace of the game also by setting the speed of the tile
animation in the Preferences dialog box.




Options Lock Discards

Allows you to lock or unlock the discarded tiles of other players so that changing of the view between the Game
board and discarded tiles affects only the visibility of your own tiles. This is useful if you wish to concentrate on
examining other players' discards and don't want that the view constantly changes (remember, if you don't lock the
discards, Four Winds automatically changes the view back to the Game board whenever it is your turn).

Four Winds automatically unlocks the discarded tiles whenever this is needed by the game situation (e.g., when
someone declares 'Out’, if you restart the deal, etc.)

Note: This command is available only when you have enabled the rule option Show discarded tiles in the
Preferences dialog box, and if you have selected the Per player radio button. The locking feature is not needed if

you use a common area for discarded tiles, as you can have your hand visible at the same time as you view other
players' discards.

Shortcut: L



Options Small Board

Toggles the 640x480 and 800x600 resolution game boards when the current display mode is at least 800x600 pixels.
If the current display mode is lower than 800x600 pixels the command is not visible.

The command is available only when there is no on-going game.

Note: To be able to use the command, you must have installed the files 4wgraph1.dll and 4wgraph2.dll (or
4wgraph3.dll and 4wgraph4.dll, if you're running the game in the 16 color mode) in the Four Winds folder during the
Setup. If you’re using a theme other than Four Winds, this command is not available. (A theme plug-in supports only
the 800x600 resolution.)



Options Sound Effects

Turns the sound effects on or off. The check mark beside the command name shows the current state of the
command.

Four Winds supports all Windows compatible sound boards. If you have a sound device and an appropriate sound
driver, you can hear sound effects in certain game situations. You can test the effects by double clicking the items of
the Sounds list box in the Preferences dialog box.

Note: You can customize the sounds from the Themes tab of the Preferences dialog box.



Options Background Music

Turns the background music on or off. The check mark beside the command name shows the current state of the
command.

In order to hear the music, you must have a MIDI device installed and enabled on your system.

You can adjust the volume of the background music by pressing on + and — keys of the numeric keypad. Notice that
some sound devices do not support programmatic volume control.

Note: You can customize the music from the Themes tab of the Preferences dialog box.



Options Auto Play
Enables or disables the demo mode.



Help Help Contents
Shows the Four Winds Help Contents and Topic Index.



Help Quick Start
Shows the Four Winds Quick Start help.



Help Keyboard shortcuts

Displays a topic on the keyboard shortcuts you can use to control the game.



Help Four Winds Web Site

Connects to Four Winds Web site where you can obtain information about the latest news and download upgrades
and theme plug-ins.



Help Tutorial
Starts an interactive presentation you can use to learn the basics of the game.

Note: The tutorial is not included in the Four Winds setup package, but you can obtain it as a separate download
from the Four Winds web site.



Help About Four Winds

Opens the About Four Winds dialog box showing the register number of the program and the version number and
copyright notice of Four Winds.




= Open Game Dialog Box

To load a Four Winds game using the Open Game dialog box, do the following:

1. Access the Open Game dialog box.

You can open the dialog box by choosing Open... from the File Menu, or by pressing CTRL+O.

2. Select the drive and folder from the standard Explorer drive and folder drop down list box.

3. Select the file from the file list box. The extension of Four Winds games is .4W. You can organize the
files using standard Explorer tools. The description of currently selected game can be seen in the
Description text box in the bottom of the dialog box.

4. Select OK, or press ENTER, to open the game file, or select Cancel or press ESCAPE to cancel the
command and close the dialog box.

Hint: You can tell Four Winds to automatically open the last saved game on program start-up by checking
the Open last saved game on start-up check box. Notice that this works only if you close the program
right after having saved the game.



» Save Game As Dialog Box

To save a new Four Winds game, or rename the currently on-going, previously saved game, do the

following:

1. Access the Save Game As dialog box.

You can access the dialog box by choosing Save As... from the File Menu.

2. Select the drive and folder from the standard Explorer drive and folder drop down list box. You can
create a new folder by using standard Explorer tools. If you change the default folder, Four Winds
asks (after the game is saved), whether the new folder is made the default folder for saved games.

3. Enter a name for the new file in the File name text box. You don’t have to enter the .4W extension,
since Four Winds adds it automatically. Enter description of the game (max. 128 characters) in the
Description text box. The description is shown when you open a game.

4. Select OK, or press ENTER to save the file, or select Cancel or press ESCAPE to cancel the command
and close the dialog box.

Hint: You can tell Four Winds to automatically open the last saved game on program start-up by checking
the Open last saved game on start-up check box. Notice that this works only if you close the program
right after having saved the game.

Note: If the file name is already in use, Four Winds will present a dialog box, where you can choose to
overwrite the file or cancel the operation. In the latter case, the Save Game As dialog box is re-displayed
so that you can enter another filename.



» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options and themes can always be changed
individually, disregarding the currently selected Rule Preset. Other options can be changed only when
using Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs:
General, Players, Game, Points I, Points Il and Themes.

General Options

Player Options
Game Options
Point Options |

Point Options Il
Themes




» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options and themes can always be changed
individually, disregarding the currently selected Rule Preset. Other options can be changed only when
using Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs:
General, Players, Game, Points I, Points Il and Themes.
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General Options

The General tab contains options that can be changed always, even while a game is going on. These
options are not saved in the rule presets. For more information, click on the controls in the bitmap.
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Game Options
Point Options |
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» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options ant themes can always be changed individually,
disregarding the currently selected Rule Preset. Other options can be changed only when using
Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs: General,
Players, Game, Points I, Points Il and Themes.
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You can define characteristics of the computer players by using the controls of the Players tab.
Game Options
Point Options |

Point Options Il
Themes




» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options and themes can always be changed
individually, disregarding the currently selected Rule Preset. Other options can be changed only when
using Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs:
General, Players, Game, Points I, Points Il and Themes.
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» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options and themes can always be changed
individually, disregarding the currently selected Rule Preset. Other options can be changed only when
using Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs:
General, Players, Game, Points I, Points Il and Themes.
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Options on this tab affect the way Four Winds calculates the points.
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» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options can always be changed individually,
disregarding the currently selected Rule Preset. Other options can be changed only when using
Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs: General,
Players, Game, Points I, Points Il and Themes.
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This tab contains additional options for determining the way Four Winds calculates the points.
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» Preferences Dialog Box

You can access the Preferences dialog box by choosing Preferences from the File Menu. Notice that
most of the options can’t be changed while a game is going on.

The Preferences dialog box consists of six tabs with separate option groups each containing several
options affecting the nature of the game. General options can always be changed individually,
disregarding the currently selected Rule Preset. Other options can be changed only when using
Customized or User Presets. Option groups can be accessed by clicking on the equivalent tabs: General,
Players, Game, Points I, Points Il and Themes.
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This tab contains controls for changing the graphics and sounds of the game, and customizing the
sounds.



» Limit & Special Hands Dialog Box
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You can access the Limit & Special Hands dialog box by choosing Select from the Points | tab of the
Preferences dialog box. Notice that you can change the settings only if you have chosen a customized
(or a saved, user-defined) rule preset, and only when there is no on-going game.

The dialog box consists of a list box of 20 commonly acknowledged Limit and Special Hands. A Limit
hand automatically pays the amount of limit points. Special hands pay a fixed amount of points. You can
toggle the selection of a hand by double clicking an item in the list box. As an item is selected in the list
box, its graphical representation and explanation in words is given at the top of the dialog box.

Notice that in Hong Kong Mah Jong certain hands, that are acknowledged as Limit hands in other rule
presets, pay only a fixed amount of points.

Accept the selected Limit Hands by selecting OK, or cancel the changes by selecting Cancel.

Note: The changes made and accepted in the Limit & Special Hands dialog box (by closing the dialog
box by selecting OK) are canceled, if the Preferences dialog box is closed by selecting Cancel.



= Points Dialog Box
You can access the Points dialog box by choosing Display Points from the File Menu.

The title bar shows the Hand Number, Wind of the Round, number of Hand in the Round, and the number
of re-deal (if applicable).

The dialog box can be rolled-up and down by double clicking the title bar (or by pressing the DEL key).
The other controls are as follows:

Total Points. Displays the Total Points for all players and the pay table (if applicable). The Winner of the
deal is marked with a green bullet ; the discarder, if any, is marked with a red bullet.

Jack, Helen, Tim, Player. Displays the details of the hand of the selected player (the tile combinations in
the hand and points they earn), including a graphical presentation of the hand.

Browse Buttons. The browse buttons enable browsing of the points of other hands played during the
game. You can also use HOME, PAGE UP, PAGE DOWN and END keys to navigate through the hands. You can
browse through the details of the winning hands by holding down the SHIFT key while clicking on the
buttons.

Print. Displays the Print dialog box, where you can setup your printer and define several print options.

Close/Resume. Closes the dialog box. If the dialog box was activated by Four Winds (at the end of the
hand), and the game is not finished, the next deal is started.

Note: To see the discarded tiles, press D. To re-display the Game board, press D again.
To see the scoring rules, see help topic Scoring.



= Print Dialog Box
You can access the Print dialog box by choosing Print from the Points dialog box.
The Print dialog box lets you setup your printer and define print options.

Printer. This option group shows information about the currently selected printer. Click on the down arrow
to pick another printer.

Properties. Press Properties to access the printer driver’s options.
Print Range. Lets you define the range of hands you wish to have point report of:
All. Prints reports of all hands of the game.
Current hand. Prints a report of the hand currently viewed in the Points dialog box.
Hands. Prints a report of the selected hands.
Summary Only. Prints a point summary of the entire game.

Print as Ascii file. Prints a simple character based report to a print file with the same name as the saved
game (4WTemp, if the game is not saved) plus the extension .txt.

Copies. Lets you define the number of copies you wish to print of each page of the report.
Cancel. Closes the dialog box.

OK. Displays a message box informing about the on-going print job and starts printing of the report. You
can cancel printing by selecting Cancel.



= Rules Dialog Box
You can access the Rules dialog box by choosing Display Rules from the File Menu.

The Rules dialog box lists all the rule options currently selected in the Preferences dialog box and
presents the information in a single scrollable text box.

To close the dialog box, click on the Close button, double click the Control Menu Box, or open the
Control Menu and choose Close.




= Rename Preset Dialog Box

You can access the Rename dialog box by choosing Rename from the Preset Popup Menu of the
Preferences dialog box.

The current name of the preset is displayed as a default choice. Enter a new name by overwriting the old
name.

Select OK to accept and save the new name, or Cancel to abort renaming.



= Save Preset As Dialog Box

You can access the Save Preset As dialog box by choosing Save As New Preset from the Preset Popup
Menu of the Preferences dialog box.

Enter a unique name for the new preset in the text box. Four Winds checks that the name is not reserved.
Select OK to accept and save the preset, or Cancel to abort saving.



= Tile Claimed Dialog Box

Tile Claimed
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[Penalty On]

If the penalty for false declaration of ‘Out’ is enabled, the Tile Claimed dialog box appears each time you
claim another player’s discard. The validation of your claim is done after you have closed the dialog box.

On the other hand, if the penalty for false declaration of ‘Out’ is disabled, your claim is pre-validated, and

the dialog box appears only if you have made a legal claim; otherwise a message box appears, informing
about an illegal claim (and about the penalty for false claim, if applicable).

There is a button in the dialog box for each possible claim you can make: Chow, Pung, Kong or Out. In
addition, you can use the Ignore button to cancel your claim, but remember that canceling a claim usually
results in penalties. You can see from the dialog box, whether the penalties for faulty claims are in use or
not.

Notice, that if you can use the tile to go out, you must choose the Out button, otherwise it may be that
another player gets the tile for a set that is more valuable than the actual set you’re needing the tile for.
Also, if you claim a winning tile for a Chow from a player who is not sitting on your left side (i.e., above
you), you are normally not allowed to have the tile, even if the rules allow claiming the winning tile from
any player. In order to have the tile in this situation, you have to choose the Out button.

If you can use the discarded tile for more than one sets, another dialog box is displayed. The number of
buttons and information displayed in this dialog box depends on the claimed tile and contents of your
hand.

E.g., if the discarded tile is Bamboo 4 and you have in your hand two Bamboo 3’s, one Bamboo 4 and
one Bamboo 5, the dialog box appears with two command buttons: 2-3-4 and 3-4-5. The second dialog
box is also displayed in situations, where you have chosen the Out button and you can use the discarded
tile to compose two different sets: a Chow or a Pung, and in some situations, a Chow or a pair.



. Koni Dialoi Box
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The Kong dialog box appears each time you legally declare a Kong. If you have made an illegal
declaration, a message box informing about this situation appears, instead.

If you have more than one options to compose a Kong, you are presented with command buttons for
each choice you have.

Select Cancel to abort the declaration.



= About Four Winds Dialog Box
You can access the About Four Winds dialog box by choosing About Four Winds from the Help Menu.

The dialog box displays the version and copyright information, and your personal registration number of
the Four Winds program. You can access further information by clicking the small arrow button at the
bottom right corner of the dialog box. E.g., in the second page you can click on the link, which connects
you to Four Winds home page on the Internet.

To close the dialog box, click on it, or press ENTER or ESCAPE.



= How To...
Discard a tile and undo the discard
View discarded tiles

Claim another player’s discard
Declare a Kong

Rob a Kong

Declare Ready

Declare Out

Accelerate the pace of the game
Use hints

Create and manage custom rule preset



= Troubleshooting

No sound

No music

Graphics don't fit in window
Presets don’t work right



First Deal Button
Displays the points of the first deal of the game. Hold down the SHIFT key to display the points for the
winner of the first deal.



Previous Deal Button
Displays the points of the previous deal. Hold down the SHIFT key to display the points for the winner of
the previous deal.



Next Deal Button
Displays the points of the next deal. Hold down the SHIFT key to display the points for the winner of the
next deal.



Last Deal Button
Displays the points of the last deal of the game. Hold down the SHIFT key to display the points for the
winner of the last deal.



Rule presets

Drop down list box containing the pre-defined and user defined sets of rules. Four Winds comes with eight pre-
defined presets: Sheer Luck, Novice, American Classical, European Contemporary, Japanese Official, Japanese
Riichi, Four Winds and Hong Kong. These rule presets can’t be changed but they can be used as a template for
creating a customized preset. Any customized setting can be saved as a new preset.

User-defined presets can be saved, renamed and deleted by using the commands of the pop-up menu accessed by
clicking on the Arrow Button on the left of the Rule Presets drop down list box.

For more information, see the help topic Creating and Managing Custom Presets.



Show discarded tiles

Enables or disables viewing of the discarded tiles. If the option is disabled, the Discards button in the Status Bar is
not visible. If the option is enabled, you can select one of the following radio buttons:

= Per Player. Displays the discarded tiles in separate areas so that each player’s discards can be seen in the

order the player has discarded them.
u Common. Displays the discarded tiles in one undivided area in the order they have been discarded.



Per player

Displays the discarded tiles in separate areas so that each player’s discards can be seen in the order the player has
discarded them.



Common

Displays the discarded tiles in one undivided area in the order they have been discarded.



Show source of discard

Enables or disables animation which reveals whether a player discarded a tile from the hand, or a tile received from
the Wall. If the discarded tile was already in the hand, the new tile (that was received from the Wall) slides into the
hand. In the Discards view the tile is zoomed in onto the Discarded tiles area. If the player discards the tile he
received from the Wall, no animation effect is used.



Show Wall on deal

If checked the Wall window is automatically displayed each time a new deal begins.



Show splash screen

Clear the check box to bypass the animation during the program start-up.



Hint on robbing a Kong

If checked, notifies you of a chance of robbing a Kong by moving the mouse pointer over the Kong button (the
caption of which has changed to read “Rob Kong*).

If the option is unchecked, the computer player’s melding is interrupted only for a couple seconds, during which time
you must click the Rob Kong button to make your claim.



Allow Undo

Enables or disables canceling of your last discard. You can draw back your discard by clicking on the tile while it is
visible in the Discard slot, or by hitting the SPACEBAR (shortcut for the menu command Undo located under the
Game Menu).



Allow Hints

Enables or disables hints in the message line. Hints include names of the tiles (displayed when the mouse cursor
moves over a tile), and the number a specified tile is played (displayed when a tile in Player’s own hand is Shift

clicked). The setting also enables the Hint command on the Game menu. (The command suggests a tile to be
discarded).



Allow Restart of hand

Enables or disables restarting of the current hand.



Discard delay
This is the time a discarded tile is displayed in the Discard slot before it is faded out (or claimed by your opponent).

The default value is 5000 (five seconds). Enter a value in milliseconds.
Note: You can always bypass the delay time during the game by pressing the ENTER key or clicking anywhere on

the game board.



Animation

These controls allow you to adjust the speed of the tile animation for each effect used in the game, or disable the
effects by setting the equivalent Frequency option to 0. Frequency affects the frame frequency of the animation (the
bigger the value, the more there are frames in the animation, and consequently, the slower the effect). Generally you
should try to adjust the animation speed by using only the Frequency setting, but if you have a fast computer, you

probably need to use the Delay setting, as well. You can test the effect by clicking on the tiles on the left of the
controls.



Player’s name

These text boxes allow you to change the default player names. Maximum length of a name is 12 characters.



Player type

These drop down list boxes allow you to define a strategy of your opponents. Brief description of each player type
follows:

= Beginner. Player is eager to claim tiles, including Chows. He’s pretty careless about discarding a tile and is
likely to suffer great losses when the Japanese rules are applied. Though he’s aiming at going out quickly, he often
spoils his chances by ignoring the importance of saving/acquiring a pair in the hand. Beginner knows most of the
double hands, but none of the limits.

u Defensive. Player is aiming at safe discards. He’s careful also in claiming Chows, or even Pungs or Kongs.
If he has a poor hand, he’s aiming at a Draw. Otherwise, he’s striving at early ready hand and going out with easy
sets, Chows, Pungs of Simples, etc. Doesn’t recognize limit hands, but is likely to aim at easy doubles (Valueless
Hand, All Simples, etc.) Good choice when using the Japanese rules, but a bit too careful for games where points are
paid to losers, as well.

u Expert. Player is adaptive and chooses his strategy according to the game situation. If he’s got an excellent
hand at the beginning, he’s likely to aim at the limit, but will change the strategy if the hand is not improving as the
game goes on. Usually strives at early ready hand without claiming discards, but he’'ll start claiming at a later stage.
He also pays attention to his discards.

u Limitmaker. Player is striving at high-scoring hands, even if the chances are only moderate. He’s rather
careless about his discards, and does not give up easily the strategy chosen at the start of the deal. He’s a poor all-
round player, especially when the Japanese rules are applied, but occasionally succeeds in getting excellent hands.

Default player types are as follows: Player — Beginner (in the demo mode only), Jack — Defensive, Helen — Expert
and Tim — Limitmaker.



Scatterbrain

This setting adds a ‘human factor’ to computer players. When the option is selected, the player occasionally “forgets*
to pay attention to other players’ discards, and sometimes evaluates ‘carelessly’ his hand, resulting in a poor choice
of discard.

Note: Don’t check this option if you want to re-play the current hand. If there are absentminded computer players in
the game, it's unlikely that the moves can be repeated exactly the same as first time!



Use extended tile set

Extends the tile set with eight special tiles: four Seasons and four Flowers, resulting in a total of 144 tiles. Extra tiles
are not acknowledged in the traditional Mah Jong, but are widely used in the popular Mah Jong, including Hong Kong
Mah Jong.

Each extra tile is worth 4 points.
In addition, each flower and season tile is assigned to a certain wind. By receiving an own Flower or Season tile a

player is paid one extra double. If a player gets all Flowers or all Seasons, additional doubles are paid, according to
the selected scoring rules.

Note: Extra tiles are not used in combinations. Instead, they are melded immediately and replaced by a Supplement
tile from the Dead Wall. This is done automatically for the human player, as well. Extra tiles that have been received
in deal are melded and replaced before the fist move.

In Hong Kong Mah Jong points for Flowers and Seasons are paid a bit differently. For more information, see the help
topic for Hong Kong Mah Jong.



Allow Chows

If enabled, allows Chows in a winning hand. Disabling Chows is rather unusual, but adds greatly to the difficulty of the
game. If the option is checked, further options are enabled:

L Maximum #. Determines the number of Chows allowed in a winning hand. Possible values are 1, 2, 3 or 4
(the default is 4, which means that the number of Chows has not been limited). Notice that certain hands (e.g.
Valueless Hand, Nine Gates, and Great Snake) are automatically disabled, if you limit the number of Chows.

L] Allow claiming from the player on the left only. This option allows claiming of a tile for a Chow only from
the player sitting on the left of the claimer, including the situation where the tile can be used to go out (this rule is
applied only in Four Winds rule preset).

= Allow claiming from all. Alternative to the previous option. Facilitates greatly the game and makes the
probability of a Draw quite low.
= Only on going Out. Modifies the previous Chow rule by restricting the right to claim the missing tile from

any player to situations where the tile is used to complete the hand and go out. In all other situations the discarded
tile can be claimed only from the player on the left. This rule is most common, and it is applied in most of the rule
presets.



Maximum number of Chows

Determines the number of Chows allowed in a winning hand. This rule is sometimes applied in the American rules.
Possible values are 1, 2, 3 or 4 (the default is 4, which means that the number of Chows is not limited). Notice that
certain hands (e.g. Valueless Hand, Nine Gates, and Great Snake) are automatically disabled, if you limit the number
of Chows.

Notice that declaring ‘Out’ with a hand consisting of more Chows than allowed is considered a faulty declaration of
Out, and the normal penalties are applied.

This option can’t be chosen, when the Hong Kong rules are used.



Allow claiming from the player on the left only

If selected, allows claiming a missing tile for a Chow only from the discard of the player that sits on the left of the
player who's claiming the tile. This includes the situation where the claimed tile can be used to go out, so if you're
used to play according a rule, which allows claiming a winning tile from any player, select the option below.



Allow claiming from all

If selected, allows claiming a missing tile for a Chow from the discard of any player.



Only on going Out

Modifies the Chow rule where a missing tile for a Chow can be claimed from any player. If checked, restricts the right
to claim the missing tile from any player to situations where the tile is used to complete the hand and go out. In all
other situations the discarded tile can be claimed only from the player on the left. This rule is most common, and it is
applied in most of the rule presets.



Allow Claiming Pair on Going Out

A common rule option in Mah Jong, and applied in all rule presets, except Four Winds. This adds greatly to the
probability that one of the players always succeeds in completing the hand.



Apply Sacred Discard

Applied in the Japanese rules, where special attention must be paid on discarding a tile. The rule forbids a player to
claim a tile that is identical to his last discard.



During Entire Deal

Modifies the Sacred Discard rule by forbidding a player to use a sacred discard, at all. This option is sometimes used
in the popular Mah Jong, and it greatly reduces the chance of going out.



Apply Missed Discard

The rule forbids a player to go out on a discard that he has missed (after his last move, and before he has made his
next draw or a legal claim). Notice that it is legal to claim a missed discard if the player does not go out immediately
after the claiming.



Apply Ready Hand Rule

If checked, an additional command, Declare Ready Hand, appears in the Game menu, and one of the following two
modifiers must be selected:

u Require Declaration. Used in the popular Mah Jong, especially by novice players. When selected, forces
players to declare that they have a ‘Ready Hand', i.e., that they need only one tile to complete the hand and go out.
Note: When this option is selected, the caption of the Out command button changes to read ‘Ready’. After the
declaration of Ready has been made, the caption will change to read ‘Out’.

u Rule of Riichi. Used in the Japanese Riichi Mah Jong. According to this rule, the hand that is to be declared
ready, must be completely concealed (Concealed Kongs are allowed, though). After the declaration, the hand is
locked and the tiles are placed face-down on the table. This means that no changes are allowed to the hand:
combinations cannot be altered, no further concealed Kongs are allowed, etc. Furthermore, a player must go out with
the first possible tile.

Going out after declaring ‘Ready’ earns one double. If another player goes out, the player(s) that declared ready must
forfeit 100 points to the winner.



Require Declaration

Used in the popular Mah Jong, especially among novice players. When selected, forces players to declare that they
have a ‘Ready Hand’, i.e., that they need only one tile to complete the hand and go out.

Note: When this option is selected, the caption of the Out command button changes to read ‘Ready’. After the
declaration of ‘Ready’ has been made, the caption will change to read ‘Out’.



Rule of ‘Riichi’

Used in the Japanese Riichi Mah Jong. According to this rule, the hand that is to be declared ready, must be
completely concealed (Concealed Kongs are allowed, though). After the declaration, the hand is locked and the tiles
are placed face-down on the table. This means that no changes are allowed to the hand: combinations cannot be
altered, no further concealed Kongs are allowed, etc. Furthermore, a player must go out with the first possible tile.

Going out after declaring ‘Ready’ earns one double. If another player goes out, the player(s) that declared ready must
forfeit 100 points to the winner.



Deal Passes on Draw

Applied in the Japanese rules. In the popular Mah Jong, it is common that the deal does not pass after a Draw (i.e.,
when no player succeeds to complete his hand).



Initial Points

Usually the Initial Points are set to 2,000. But if the rules allow collecting of hands that result in high scores, the Initial
Points should be increased accordingly.



Limit Points

Default setting for Limit Points (the maximum score) is 500. The limit is applied if the total score of the hand (i.e., the
score after the doubles) exceeds the set limit value. That means that the maximum pay points a player can receive is
3,000 if the winner is the dealer (each loser pays the dealer twice the amount of the total score), and 2,000 if the
winner is not the dealer (East pays 1,000, other losers each 500 points). Notice that penalties and bonuses for
dealer’s extra hands are paid independently of the scoring, i.e., these points are added to/reduced from the pay
points after all other calculations have been made.

In the Hong Kong rules the limit is 128 points and the setting can’t be changed. The maximum pay points a player
can receive in the Hong Kong Mah Jong is thus 394 points (128 from each of the other players). The limit is paid for
certain limit hands and hands worth 10 or more tile points, resulting in 128 points, if the hand is completed on a self-
drawn tile.



Minimum Points

Applicable only if you have chosen the Hong Kong style paying method. The default for minimum points is 0, in which
case all hands are allowed as winning hands. Other possible values are 1, 2, and 3 points.

E.g., if the amount of minimum points is 3, the winning hand must be worth three or more points (for example, three
points for All Pungs/Kongs, or one point for All Chows + one for own Flower, and one for a self-drawn winning tile).

Notice that declaring ‘Out’ on a hand with too few points is considered a faulty declaration of Out, and the normal
penalties are applied.



Allow Special Hands

Checking this option enables the Select button. Clicking the Select button displays the Limit & Special Hands
dialog box, where you can view which hands are included in the game as limit and special hands. Notice that in order
to be able to change settings in the Limit & Special Hands dialog box, you must have chosen a customized rule
preset.




Select Button

Displays the Limit & Special Hands dialog box, where you can view which hands are included in the game as limit
and special hands. Notice that in order to be able to change settings in the Limit & Special Hands dialog box, you
must have chosen a customized rule preset.




Points Are Paid Between All Players

Used normally in the modern European and American Mah Jong. In contrast to the Japanese rules, the winner is paid
by all the players, even if he goes out on a discarded tile. In addition, the losers settle among themselves for the
values of their uncompleted hands, paying the difference to one having a better hand (East pays and receives
double). Losers are allowed to count points for complete Pungs and Kongs, but rules vary as to what other kind of
sets are allowed in the point calculation. (See further options on this tab.)



Lucky Pairs

If checked, the losers receive two points for a pair consisting of Dragons, player’s own Wind or the Prevailing Wind.



Little Three Dragons

If checked, the losers receive three doubles for a hand consisting of two triplets (Pung or Kong) of Dragons and a pair
of Dragons.



Flowers and Seasons

If checked, the losers receive one double for player’s own Flower or Season, and two or three doubles (according the
selected rule, see below) for having all Seasons or Flowers.



Points Are Paid to Winner Only by Discarder/All Losers

Applied in the Japanese rules. According to this rule the discarder (player on whose tile the winner went out) pays
alone to the winner, and losers don’t settle points among themselves. The rule calls for defensive playing strategy
and changes radically the nature of the game. If this option is selected, an additional option is enabled (see the option
below).



Pay for Ready Hands After Draw

Modifies the rule where points are paid to the winner only. Applied sometimes in the popular Japanese Mah Jong. If
checked, a total of 600 points is paid to players having a ready hand by players not having a ready hand. (Note:
Players don’t need to have declared ‘Ready’.) That means, that if three players have a ready hand, the one whose
hand is not ready pays 200 points to each having a ready hand. If two players have a ready hand, the ones whose
hands are not ready pay each 150 points to those with a ready hand. If only one player has a ready hand, the other
three pay him 200 points each. In all other cases, no points are paid.



Points Are Paid to Winner Only (Hong Kong style)

Changes radically the way of scoring and payments. For more information, see the help topic for Hong Kong Mah
Jong. If this option is selected, an additional option is enabled (see the option below).



Discarder Pays for All

Modifies the Hong Kong rules so that the discarder always pays on behalf of other players. Normally the discarder
pays double and other losers pay normally. If this option is enabled, the discarder alone pays all these points.



Bonus for Dealer’s Extra Hands

If enabled, applies the rule, according to which the dealer is paid extra 100 points (8 points in Hong Kong Mah Jong)
per loser for each hand he wins in sequence. The bonus is incremental: the first time (after two successive wins) the
dealer receives 300 points (24 points), the second time 600 points (48 points), third time 900 points (72 points), etc.
After the seventh successive win, the limit is applied, after which the deal finally passes to the next player.



Set Acknowledged Hands

Click to display a list of hands that are not universally acknowledged. If you have chosen a customized rule preset,
you can toggle the selection by double clicking an item in the list.

L Concealed Hand. In the Japanese rules, a concealed hand normally receives 10 bonus points, if the last tile
is acquired by claiming a discard, and one double, if it is received from the Wall. In the American rules a concealed
hand is sometimes not acknowledged at all. If applied in Hong Kong rules, this hand pays one extra point.

u All Simples. Hand consists only of Suit tiles from 2 to 8. Acknowledged in the Japanese rules, according to
which this hand receives one double, but usually rejected in other rules because of its easiness. If applied in Hong
Kong rules, this hand pays one extra point.

= Terminal or Honor in Each Set. Usually acknowledged only in the Japanese rules. If applied in Hong Kong
rules, this hand pays one extra point.

= Four Triplets, 3 Concealed. In the Japanese rules this hand receives two doubles, but is usually rejected in
other rules. If applied in Hong Kong rules, this hand pays two points.

u Three Triplets, All Concealed. In the Japanese rules this hand receives one double, but is usually rejected
in other rules. If applied in Hong Kong rules, this hand pays one extra point.

u One through 9 of One Suit. In the Japanese rules this hand receives one double, but is usually rejected in

other rules. If applied in Hong Kong rules, this hand pays one extra point.

= No Simples. Normally acknowledged by all the versions as a hand receiving one double. If applied in Hong

Kong rules, this hand pays one extra point.



Set Bonus & Double

Click to display a list of hands that score differently in different rules. If you have chosen a customized rule preset,
you can change the setting by double clicking an item in the list. (The options can’t be changed when points are paid
in Hong Kong style.)

L] Special Ways of Going Out. These include the following special cases: Going out on the last tile of the Wall,
Going out on the last discard (i.e., after the last tile of the Wall has been drawn), Going out on a robbed Kong, and
Going out on a Supplement tile. In the Japanese rules, these hands receive 1 double each, but in other rules normally
only 10 points. In Hong Kong Mah Jong, these are worth one point each.

u Valueless Hand (4 Chows). Hand that consists only of Chows and a valueless Pair. Normally it is also
required, that the hand is completed on a discarded tile. In the Japanese rules, the hand pays 1 double, but in other
rules normally only 10 points. In Hong Kong Mah Jong, a hand consisting of Four Chows receives one point (and
there are no special requirements for the way hand is completed). If the Chows are disabled (or the number of Chows
has been limited), this option is disabled.

u No Chows. In the Japanese rules, this hand pays 1 double, but in other rules normally only 10 points. In
Hong Kong Mah Jong, this hand receives three points.

u One Suit Only. In some rules, this hand pays 4 doubles, but normally only 3 doubles. In Hong Kong Mah
Jong, the hand pays 6 points.

u All Flowers or All Seasons. Normally all Flowers or Seasons are worth 2 doubles, but in some rules they
are worth 3 doubles. If the extended tile set is not in use, this option is disabled. In Hong Kong Mah Jong, All Flowers
of All Seasons both pay 3 points.



Acknowledged Hands and Bonus & Double List Boxes

Toggle the selection or change the rule by double clicking on an item. Notice that you must have chosen a
customized rule preset in order to be able to change the settings.



Allow One-Chance/Self-Drawn Last Tile in a Valueless Hand

In the Japanese rules, it is required that a Valueless Hand is completed with a discarded tile and that the winning tile
is not a one-chance-tile (e.g., Bamboo 7 that completes a Chow of Bamboo 7, 8 and 9). A one-chance tile and the last
tile from the Wall are normally worth 2 extra points each, which means that the hand is not completely valueless. In
other rules this is not required, in which case these hands don’t receive the extra 2 points, either.

Notice that a Valueless Hand can receive normal doubles (e.g., for being One Suit Only, for going out on a last
discard or on a robbed Kong, etc.).

The option can’t be changed when points are paid according the Hong Kong style. The option is disabled if no Chows
are allowed (or if the number of Chows have been limited).



Apply Penalty Points for Faulty Declaration of ‘Out’

Penalties are usually optional, but are often applied among experts. Faulty declaration of ‘Out’ results always in
ending of the hand. The amount of the penalty points is determined by the Limit Points (normally 500 points). If the
offender is a non-dealer, he must pay half of the limit to each of the other non-dealers, and limit to the dealer, the total
penalty amounting to 1,000 points (supposing that the limit is 500 points). If the offender is the dealer, he must pay
limit to each of the other players, the total amounting to 1,500 points. In Hong Kong Mahjong, the amount of Limit
points is paid to each of the other players.



Apply Penalty Points for Faulty Claims

Penalties for faulty claims are usually optional, but are often applied by experts. lllegal claim of Kong, Pung or Chow,
or canceling of the claim, results in reducing 100 points from the offender’s final pay points. These points are received
by the winner at the end of the hand. If the hand ends in a Draw, or if the offender himself wins the hand, he reclaims
the penalty.

The option is not used in Hong Kong Mah Jong.



Apply Penalty Points for Five Last Tiles Error

If there are five or less tiles left in the Wall, and the player discards a tile that has not been played already (i.e., that is

not visible on the board or amongst the discarded tiles), and another player claims the tile and goes out, the discarder
must pay to winner on behalf of other players.

Notice that this penalty is meaningless (and can’t be chosen), if you have applied the rule according to which
discarder always pays for all players.



Apply Penalty Points for Nine Tiles Error

This penalty is applied, if one of the players (e.g., player A) has three (or four) melded Pungs or Kongs of the same
suit, and another player (B) discards a tile of the same suit. If the discarded tile is claimed by player A, and he goes
out and the winning hand is All One Suit, the discarder (B) must pay the winner on behalf of the other players. Notice
that the penalty applies even if the player claims the tile and composes a fourth set of the same suit, provided that he
subsequently goes out on a self-drawn tile, and the winning hand is All One Suit. However, if a third player (C) also
discards a tile of the same suit, and player A claims the tile and goes ‘Out’, the penalty is applied to player C.



Rounding Off to Nearest Ten

In the traditional Mah Jong the points are rounded off to nearest ten to simplify the paying. Though this is not
necessary in Four Winds, where the calculations are done by computer, this option is retained for the sake of
completeness. If checked, further options are available. (See below.)

The option is not used in Hong Kong Mah Jong.



Before Doubles

Rounding is done after the hand points are summed up, but before the doubles are applied. E.g., if a player goes out
with 24 points and 2 doubles, the hand points are first rounded off to 20 and then multiplied by four, resulting in 80
points. On the other hand, going out with two points more, 26 points, would result in 120 points!

The option is not used in Hong Kong Mah Jong.



After Doubles

Rounding is done after the doubles are applied. E.g., if a player goes out with 24 points and 2 doubles, the points are
first multiplied by four, which makes 96 points, which is rounded off to 100 points. Going out with 26 points would
result in 100 points, as well. This method of rounding is used most often.

The option is not used in Hong Kong Mah Jong.



Themes

When there is no on-going game, you can change the theme of the game. A theme is a complete visual and aural
design, consisting of tiles, game board, cursors, controls, and sounds that are designed to work well together. The
version 1.0 comes with two themes: Four Winds and Bauhaus. Additional themes will be available later.

To change the theme, open the Themes drop-down list box and select another theme. You can see a preview of the
visual look of the theme.



Sounds
Each theme comes with a complete set of sounds assigned to different game events, and a MIDI file for playing the
background music. As you change the theme, sounds associated with that theme are displayed in the Sounds list.

To play a sound, double click the name of the sound event. Stop playing by clicking the sound event (or any other
control on the tab).

To customize the sound, first select the associated sound event in the Sounds list, then choose another sound by
using the Name drop-down list box or the Browse button. The icon associated with the sound event tells you whether
the sound is internal (one belonging to the original theme) or customized.



Name

The Name combo list box displays the name of the sound file assigned to the currently selected sound event (or for
background music). The name is “Internal”, if the sound is not customized.

You can customize the sound event or background music by choosing another sound from the list associated to the
control. The list contains the wave (or MIDI) files in the currently selected media folder (Windows\Media in
Windows95). To select another sound (or another sound folder), click the Browse button.



Browse

Click to open a dialog box for browsing the wave or MIDI files of the currently selected media folder (Windows\Media
in Windows95). You can preview the sound in the dialog box by clicking the Play button. To stop a sound, click on
another sound file. Click the Open button to assign the sound file to the currently selected sound event.

The contents of the last selected media folder can be seen in the Name combo list box, so you can easily customize
the rest of the sound events.



Context Help

Changes cursor’s shape to a question mark. Click on any of the controls in the tab to display help on that item.



Cancel

Cancels all changes you have made to preferences after opening the Preferences dialog box.



OK

Applies all changes you have made to preferences and saves the new settings to the registration database.



Preset Menu Button

Displays the Preset pop-up menu with commands enabling saving, renaming and deleting of custom rule presets.
Save az Mew Preset. .
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Four Winds MIDI files
Four Winds MIDI files, copyright 1996—1997 by Timo Seppanen. {mci PLAY EXTERNAL NOPLAYBAR,4Winds2.mid}
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Discarding a tile and undoing a discard

When it is your turn and you have received a new tile from the Wall, a Supplement tile from the Dead Wall
(after declaring a Kong, or receiving a Season or a Flower tile), or a discarded tile from one of your
opponents, you must make your move: either declare out, or discard one of your tiles.

To discard a tile:

" Lift the tile you wish to discard. Clicking on a non-lifted tile lifts it up, and slides any other tile
that was previously lifted back to the row. Clicking on a lifted tile again puts it back to the row.
" Release the lifted tile by clicking it with the right mouse button, or by pressing the

SPACEBAR. You don’t have to click on the tile: right clicking anywhere on the game board releases the
lifted tile and completes your move.

" The discarded tile zooms out from the hand, and zooms in into the Discard slot, where it is
available for other players. You can undo your move as long as the tile shows in the Discard slot.

To undo your discard:

You can draw back the tile you have just discarded as long as the tile is visible in the Discard slot.
L] Click on the discarded tile, or press the SPACEBAR. The tile moves back to the hand.

Note: Undo is available only if you have enabled it in the Preferences dialog box. Notice that you can’t
undo anything else than your last discard, and not even that after the tile has disappeared from the
Discard slot. (But if you want to cheat, you can enable an option that lets you restart the hand, or you can
save a game and then reload it.)




Viewing discarded tiles

If you have enabled viewing of the discarded tiles using one of the options in the Preferences dialog box,

To display the discarded tiles, click located in the Status bar, or press D.

To return to the Hands view, click , or press D again.

Depending on the setting you have chosen, the discarded tiles are displayed in separate areas, or in one
area common to all players. If the discards are displayed in separate areas, you can lock the view so that
other players' discarded tiles stay always visible independently of the current view. To lock or unlock the
discards, choose Lock discards under the Options menu (shortcut: L).



Claiming another player’s discard

After a computer player has discarded his tile the tile stays visible in the Discard slot during the time
determined by the Discard delay set in the Preferences dialog box. As long as the tile is visible, you can
claim the discarded tile to complete a set in your hand. Valid claims (whether and when you can claim a
Pair and a Chow) are determined by the rules. E.g., normally you can claim a tile for a Chow only from a
player on the left, except when you can use the discarded tile to go ‘Out’, in which case the tile can be
claimed from any player. Normally you can also claim a tile to a Pair if you can use it to go ‘Out’.

Precedence of claims

If two or more players claim the same tile, the precedence of claims is as follows: Chow, Pung, Kong
and Out, the last being the most powerful. E.g., if one player is claiming the tile for a Chow, and
another for a Pung, the player claiming for a Pung will get the tile.

If two or more players claim the same tile and their claims are equally powerful (both claim the
discarded tile for a Chow or for going ‘Out’), the player who would have played first receives the tile.

To claim a tile:

. Click on the discarded tile, or hit the SPACEBAR. If the penalty for faulty declaration of Out is
enabled, the Tile Claimed dialog box appears. Your claim is validated after you close the dialog box. If
the penalty for faulty declaration of Out is disabled, Four Winds first checks, whether your claim is legal,
and displays the Tile Claimed dialog box only for legal claims. Otherwise, a message box informing
about an illegal claim is displayed.

" Click one of the buttons (Chow, Pung, Kong, or Out) of the Tile Claimed dialog box. Or click
Ignore, if you want to change your mind and cancel the claim. If penalties are in use, canceling a claim
costs you 100 points. There is a label in the dialog box, which tells you whether the penalties will be
applied.

" Notice, that if you can use the tile to go out, you must click Out, otherwise another player may get
the tile for a set that is more valuable than the actual set you're needing the tile for. Also, if you claim a
winning tile for a Chow from a player who is not sitting on your left side, and you have enabled the rule
that allows claiming a tile for a Chow from any player only on going out, you will make a faulty claim, if
you click on Chow, instead of Out.

. If you have more than one option to compose a set (e.g., several possibilities to compose a
Chow, or in case of having clicked Out in the previous dialog box, a possibility to decide whether to
compose a Chow or a Pung, or a Chow or a Pair), another dialog box is displayed, where you can specify
your claim.

. If you confirm the claim, the discarded tile is zoomed out from the discarder’s Discard slot and
zoomed in on your Melded Tiles Row along with the other tiles in your hand composing the completed
set.




Declaring a Kong

You can declare a Kong on your turn, if you have:

" Four similar tiles in the hand.
" A Melded Pung, and the fourth similar tile just or previously received from the Wall or Dead Wall

(as a Supplement tile).

To declare a Kong:
m Click
B in the Status bar.

If your claim is valid, the Kong dialog box appears. Otherwise, a message box informing of an
illegal declaration is displayed. If you confirm the declaration, the tiles forming the Kong are zoomed out
from the Hand Tiles Row and zoomed in on to the Melded Tiles Row. In case of completing a Pung to a
Kong, the fourth tile is inserted on the Melded Tiles Row right after the third tile of the Melded Pung.

. After the tiles have been melded you receive a Supplement tile from the Dead Wall (unless there
are no tiles left in the Wall, in which case the deal ends right after the tiles have been melded).




Robbing a Kong

If another player declares a Melded Kong by completing a Melded Pung with a fourth similar tile just or
previously received from the Wall or the Dead Wall, you may ‘rob’ the tile, if you can use it to go out.

When you have a chance to rob a Kong, the caption of the Kong command button changes to read ‘Rob
Kong’. Now you have five seconds time to response to this clue and click on the Rob Kong button.

You can have Four Winds notify you of a chance of robbing a Kong by checking the Hint on robbing a
Kong option in the Preferences dialog box.

To rob a Kong:
u Click
AR in the Status bar.
The fourth tile is zoomed out from the Hand Tiles Row of the player who was about to declare a
Kong, and zoomed in on to robber’s Melded Tiles Row along with the other two tiles composing the set
(this is always a Chow).




Declaring ‘Ready’

If you need only one tile to go out, you have a ‘ready’ hand.

If one of the ready hand rules is checked in the Preferences dialog box you may need to “declare ready*,
that is, to inform other players that you have a ready hand.

Note: When a player declares ready, a sound is heard, and the color of his name appearing on the Claim
Column changes.

To declare a Ready hand when it is required by the rules in order to go out:
u Click
in the Status bar
or choose Declare Ready Hand under the Game Menu (shortcut: CTRL+Ri.

After you have made the declaration, the caption of the command button changes to

To declare a Ready hand (Rule of Riichi):

" Choose Declare Ready Hand under the Game Menu (shortcut: CTRL+R). After you have made
the declaration, and made your move by discarding one of the tiles in your hand, your tiles are turned
face-down and locked. From now on you can’t make any changes to your hand, not even declare a Kong.
The only tile you may keep (either received from the Wall or by claiming another player’s discard), is one
that you can use to go out.

Note: The Rule of Riichi requires that the Ready Hand is completely concealed (Concealed Kongs may
exist, though).



Declaring ‘Out’

A complete hand consists of four sets of Chows, Pungs and/or Kongs, and a pair. (For exceptions to the
regular tile combinations, see Limit and Special Hands in the help topic Scoring.)

If you can complete your hand by claiming another player’s discard, you can declare ‘Out’ while you’re in
the Tile Claimed dialog box. This way you can ensure that no one takes the tile for a less valuable
purpose. (E.g., if you claim the tile for a Chow in the Tile Claimed dialog box, instead of clicking on the
Out button, another player may take the tile for a Pung!)

If you receive the winning tile from the Wall (or if you have claimed the winning tile from another player’s
discard, but didn’t choose the Out button in the Tile Claimed dialog box), you can declare ‘Out’ while it is
your turn.

To declare ‘Out’ while it is your turn:
. Click
= in the Status bar.

After the declaration the hand ends. If your declaration is valid, all tiles are turned face-up and the
Points dialog box appears. Otherwise a message box informing about illegal declaration (and appropriate
penalties) appears. If penalties for faulty declaration of ‘Out’ are enabled, the Points dialog box appears.
Then a new deal is started (unless the game didn’t end).

To declare ‘Out’ while claiming a discarded tile:
. Click
= in the Tile Claimed dialog box.



Accelerating the pace of the game

If the tile animation seems too slow, try to adjust the speed by using the Animation settings of the
Preferences dialog box. If none of the settings work, you should disable the tile animation altogether.

Disregarding the Discard delay and Animation settings you have made in the Preferences dialog box,
you can bypass these settings in certain situations by clicking anywhere on the Game Board:.

. Release a discarded tile immediately. Normally the discarded tile stays visible in the Discard
slot during the time specified in the Discard delay setting. Clicking on the Game Board immediately
releases the tile, after which a new tile is given to the next player, or if the tile is claimed, appropriate
procedures are carried out.

. Discard your new tile immediately. In the end game, when you have most of the sets
completed and are waiting for a particular tile, you can quickly discard a new tile without moving the
mouse cursor by right clicking anywhere on the Game Board.

. Bypass the animated deal. If the Show Deal command under the Options Menu is checked, the
tiles are dealt incrementally according to the traditional deal method. By clicking on the Game Board, you
can bypass the animation and complete the deal.

" Bypass the animated turning of the tiles. When the tiles are turned face-up or face-down as a
consequence of the Show Tiles command under the Options Menu, or as a result of one of the players
declaring out, you can bypass the animation by clicking on the Game Board.

Notice, that the game messages (e.g., your opponents’ declarations) are shown in a message box by
default. You can accelerate the game by defining, that most of the messages are shown in the message
line, instead. To show the messages in the message line, clear the check mark beside the Show
Messages command (Options menu). The setting is saved as a new default for this command.




Using Hints

The hints, if enabled in the Preferences dialog box are displayed in the Message Line. The hints include:
" Hint on tile to be discarded. When it is your turn, you can display suggestion for the tile to be
discarded by clicking Game Hint, or by pressing H. The quality of the hint is determined by the player
setting in the Players tab of the Preferences dialog box.

" Description of the tile the mouse cursor is currently over. Learning to recognize the Mah
Jong tiles is not difficult, but if you need help, just move the mouse cursor over the tile and read the tile’s
name from the Message Line.

. Number a particular tile is played. If you have enabled Show discarded tiles in the
Preferences dialog box, you can count the number a particular tile has been played so far. You can do
this also by pressing down Shift and clicking on the tile in your Hand. If the tile is a Suit tile (e.g., Bamboo
3), the Message Line displays also the number the adjacent Suit tiles (Bamboo 2 and Bamboo 4) have
been played.




Creating and managing custom rule presets

In addition to the pre-defined rule presets that come with Four Winds, you can save a customized rule
settings as a new preset. You can also rename and delete your own presets. Rule presets are managed
using the General tab of the Preferences dialog box.

Notice that the options of the General, Players and Themes tab are not included in the presets. All other
options are saved.

Creating a new preset
Saving an existing user preset
Renaming a user preset

Deleting a user preset




Creating and managing custom rule presets

In addition to the pre-defined rule presets that come with Four Winds, you can save a customized rule
settings as a new preset. You can also rename and delete your own presets. Rule presets are managed
using the General tab of the Preferences dialog box.

Notice that the options of the General, Players and Themes tab are not included in the presets. All other
options are saved.

Creating a new preset
. Select ‘Customized’ from the Rule Preset drop-down list box. You can use an existing preset

as a starting point by selecting that preset first, and then selecting Customized. You can also make
changes directly to any of the presets you have created previously, and rename it, but then you lose the
preset you used as a starting point.

" Make changes to individual options. After you have selected Customized from the Rule Preset
drop-down list box, or any of your own presets, all the rule and scoring options can be edited.

. Choose the General tab and click on the arrow on the left of the Rule Preset drop-down list box.
Choose Save As New Preset from the Preset Pop-up Menu.

" Enter a unique name for the new preset in the text box of the Save Preset As dialog box and
select OK. The new preset appears in the Rule Preset drop-down list box and is selected as a current
preset.

Note: You can use the same method to save the rules of the currently played saved game (provided that
the rules are customized). This is handy if you like the settings of the saved game and want to save them
for future use. Notice that Four Winds reverts to default rules (those that were active before you loaded
the saved game) as soon as you close the saved game, so if you want to continue with the same settings
(and they differ from those that were active before), you'll first have to activate the rule preset to which
you saved the settings.

Saving an existing user preset

Renaming a user preset
Deleting a user preset




Creating and managing custom rule presets

In addition to the pre-defined rule presets that come with Four Winds, you can save a customized rule
settings as a new preset. You can also rename and delete your own presets. Rule presets are managed
using the General tab of the Preferences dialog box.

Notice that the options of the General, Players and Themes tab are not included in the presets. All other
options are saved.

Creating a new preset
Saving an existing user preset

. Select the user preset you wish to edit from the Rule Preset drop-down list box. You can
make changes only to user presets.

" Make changes to individual options.

" Click General to re-display the General tab and click on the arrow on the left of the Rule Preset

drop-down list box. Choose Save from the Preset Pop-up Menu.

Note: If you have made changes to an existing user preset and close the Preferences dialog box by
selecting OK without saving first the changes to the preset, Four Winds warns you about this situation
and lets you save the changes.

Renaming a user preset
Deleting a user preset




Creating and managing custom rule presets

In addition to the pre-defined rule presets that come with Four Winds, you can save a customized rule
settings as a new preset. You can also rename and delete your own presets. Rule presets are managed
using the General tab of the Preferences dialog box.

Notice that the options of the General, Players and Themes tab are not included in the presets. All other
options are saved.

Creating a new preset

Saving an existing user preset

Renaming a user preset

" Select the user rule preset you wish to rename from the Rule Preset drop-down list box.
You can rename only user presets.

n Click on the arrow on the left of the Rule Preset drop-down list box. Choose Rename from the
Preset Pop-up Menu.

. Enter a new name for the preset in the text box of the Rename Preset dialog box and select OK.
The renamed preset appears in the Rule Preset drop-down list box and is selected as a current preset.

Deleting a user preset




Creating and managing custom rule presets

In addition to the pre-defined rule presets that come with Four Winds, you can save a customized rule
settings as a new preset. You can also rename and delete your own presets. Rule presets are managed
using the General tab of the Preferences dialog box.

Notice that the options of the General, Players and Themes tab are not included in the presets. All other
options are saved.

Creating a new preset

Saving an existing user preset
Renaming a user preset

Deleting a user preset

. Select the user rule preset you wish to delete from the Rule Preset drop-down list box. You
can remove only user presets.

. Click on the arrow on the left of the Rule Preset drop-down list box. Choose Delete from the
Preset Pop-up Menu.

" Confirm the deletion by selecting Yes, or cancel the command by selecting No. The deleted
preset is removed from the Rule Preset drop-down list box.




Troubleshooting — No sound

If you can’t hear the sound effects while you're playing Four Winds, do the following:

1.

Make sure you have enabled sound effects by checking the Sound Effects command in the Options
menu of Four Winds.

Make sure you have installed the Four Winds wave resource file (4wwave.dll) in the Four Winds
program folder. If not, reinstall Four Winds.

Make sure you have a wave device installed, configured and operational. Try to play Tada.wav or
another system wave file using Media Player or some other wave player.

Make sure that device’s mixer settings (Wave Out and Wave Output Level) are correct. Mixer settings
are controlled by Volume Control or by a proprietary mixer application. If the settings are incorrect,
re-adjust and try to play a .MID file again.

Open Control Panel and double click the Multimedia applet. Click Advanced tab and expand Audio
Compression Codecs. Make sure that Microsoft IMA ADPCM Codec and Microsoft ADPCM
Codec audio compression drivers have been installed. If so, check the Properties of both drivers and
make sure they are enabled. Wave files that come with Four Winds are compressed .WAV files. You
can’t play them unless you have support for audio compression on your system.



Troubleshooting — No Music

If you can’t hear the background music of Four Winds, do the following:

1.

Make sure you have enabled background music by checking the Background Music command in
the Options Menu of Four Winds. Make sure you have installed the Four Winds .mid files in the Four
Winds program folder. If not, copy the files to correct folder, or reinstall Four Winds.

Make sure that no other program reserves the MIDI device. Only one program at a time can use the
MIDI device.

Open Media Player and try to play Canyon.mid or any of the .MID files that come with Windows 95. If
you don’t hear music, continue to the next step. Otherwise, continue using Media Player and try to
open one by one each of the Four Winds .mid files. If you can't open a file, or if you can't hear music
while playing it, it is obvious that the file is corrupt. Remove the corrupted file from Four Winds
program folder and copy the original file by re-installing Four Winds.

Make sure you have a sound device (an ordinary sound card with OPL synthesizer will do) installed,
configured and operational. Try to play Tada.wav or another system wave file using Media Player or
some other wave player. If the sound plays, continue to next step. Otherwise consult your Windows

95 on-line Help.

Open Control Panel and double-click the Multimedia applet. Click on Midi tab and check that you
have a Midi device installed. If there are more than one MIDI devices listed, make sure you have
selected a correct MIDI device. Click Advanced tab and expand Midi Devices and Instruments.
Open the Properties of your MIDI device and make sure that Use MIDI features on this device
option is selected.

Click Details tab and make sure you have a proper instrument definition for your MIDI device. You
should have the following definitions: General MIDI Instrument and Percussion on Channel 16.

Make sure that the device's mixer settings are correct. (If you have no a device specific mixer, choose
Device Volume Control from the Media Player). E.g., check that MIDI Out channel is not muted and
that its sound level is correct. If not, re-adjust and try to play a .MID file.



Troubleshooting — Graphics Don’t Fit in Window

If part of the graphics seems to cut out or extend beyond the window, do the following:
1.

2.

If you’re using large system fonts, try to change to medium or small size system font.

If you’re using customized measures in screen elements (like borders, title rows, etc.), try settings that
are closer to the standard.



Troubleshooting — Problems with Printing

If you have problems with printing the point reports, do the following:

1.
2,

Make sure you have your printer operational. Try to print any simple text file using Notepad.

Check from the Printers applet of Control Panel that you have an appropriate printer driver installed
and configured (port settings). If not, add a printer driver for your printer.

Make sure that you selected a suitable printer in the Four Winds Print dialog box and check from
Properties that the printer has correct settings. You need to have a printer that is capable of printing
graphics and use scaleable fonts.



Troubleshooting — Presets don’t work right

If you have problems with the rule presets (e.g., actual settings used in the game are not those selected
from the Preferences, or custom presets do not load correctly), it is probable that the configuration file for
presets (4winds.cfg), is corrupt. Do the following:

1. Close the Preferences dialog box, if necessary.
2. Delete the file 4winds.cfg under the Four Winds program folder.

3. Open the Preferences dialog box, and Four Winds re-creates the configuration file with the default
presets.



Quick Start — A test drive

To get the feel of Four Winds’ concept of Mah Jong and to learn the basic game controls, follow these
steps. It is assumed that you have chosen the default rule preset, European Contemporary. (If not, open
the Preferences dialog box by choosing File Preferences and select European Contemporary from the
Rule Presets drop-down list box of the General tab.)

1.

Your goal is to collect four sets of Chows, Pungs or Kongs, plus one Pair and go ‘out’. Start a new
game by choosing Game New (shortcut: F2).
For more information about the goal of the game, see the help topic Playing.

Enjoy the animated deal, or ignore it by clicking anywhere on the Game Board.

a) If it is not your turn:

If it's another player’s turn, force the computer player to discard his first tile by clicking anywhere on
the game board. Normally, when a deal starts and the dealer is one of the computer players, there is
a delay of 20 seconds before the first tile is discarded. Clicking on the game board stops the timer
and forces the player to make his move immediately.

The discarded tile appears in the discarding player’s Discard slot. If you want to claim the discarded
tile in order to compose a melded Chow, Pung or Kong, click on the tile in the Discard slot, or press
the SPACEBAR. The Tile Claimed dialog box appears, and you can either confirm or cancel your
claim. For more information about claiming rules, see Variations.

If you don’t want to claim a tile, wait for five seconds until the next player receives a new tile from the
Wall. If you don’t want to wait that long, just click anywhere on the game board to accelerate the
game. EE—

Repeat the step 3 a) until it's your turn. Then move to step 3 b).

b) If it is your turn:

If it's your turn, make your move. To make a move, you must first click a tile you wish to discard so
that the tile moves up a bit and stands out from the rest of the tiles. Right clicking on a lifted tile (or
anywhere on the Game Board above the Hand Tiles Row), or pressing the SPACEBAR, completes the
move and releases the tile. A discarded tile appears in your Discard slot. To undo your move, click on
the tile in the discarded slot, or hit the SPACEBAR again.

Tip: If you prefer using the keyboard, you can select the tile to be discarded using arrow, HOME and
END keys. For detailed help on using the keyboard, see Keyboard shortcuts.

Repeat receiving, discarding and claiming tiles as advised in the step 3, until you need only one tile to
complete your hand and go ‘out’, or until one of the computer players declares ‘Out’.

If you receive the last tile you need to complete your hand from the Wall, declare ‘Out’ by clicking the
Out button located in the Status bar. If you get the final tile from another player’s discard, click the
Out button of the Tile Claimed dialog box (the actual set you're claiming the tile for doesn’t matter:
you must indicate the final purpose of your claim). For more information, see the help topic Declaring
‘Out’.

If you or one of your opponents succeeds to go out, the deal ends and the points are displayed in the
Points dialog box. Click the Resume button to continue with the next deal.

If there are no tiles left in the Wall and none of the players declares ‘Out’, the deal ends in a Draw.

The complete game of Mah Jong consist at least of 16 deals. If you want to continue playing some
other time, choose File Save As (or press CTRL+S). Enter a name and description for the game and
click OK. Abort the game by choosing Game Abort, or by pressing CTRL+Q. When you want to
continue playing a saved game, choose File Open, use the standard Windows 95 Explorer tools to
find the saved game file, and click OK.

If you know the rules of Mah Jong, or want to learn them by playing, rather than by reading a bunch of
help topics, just go ahead and continue playing. If you get in trouble, just press F1, and search for help



topics using the Contents, Index and Find tabs.

If you're new to the game of Mah Jong, or want a guided tour to familiarize yourself with the user interface
of the game, you may want to continue with the next section.



Quick Start — Learning the game

If you have not played Mah Jong previously, you can follow these steps to familiarize yourself with the
game:

1.
2.

Read the Basics section of the help topic Playing.

Learn to know the tiles.

Tip: Enabling Allow Hints in the Preferences dialog box allows you to read the names of the tiles
from the Message Line. (The setting is enabled by default.) Checking Options Show Identificators
menu option allows you to see the identificating numbers and letters on the tiles.

Make sure that there is a check mark beside the Show Messages command (Options menu). This
shows the game messages in a dialog box, instead of the message line. This way you have
adequately time to see each player’s actions.

Choose File Preferences and click on the Players tab. Type your name in the first player’s name text
box. You can change the names of other players, as well. Select OK to apply changes and close the
Preferences dialog box.

Now start a new game by choosing Game New (shortcut: F2).

Choose Options Show Tiles to display the tiles of your opponents. This allows you to learn the
basics of the game: you learn to recognize the tile sets (Chow, Pung and Kong) and see how they are
claimed and melded.

Tip: You can have the computer make your moves, as well, by choosing Options Auto Play. To
return control to yourself, choose the same command again.

Learn to know more advanced features of the game by reading the Regular pace of the game and
Special cases sections of the help topic Playing. The most common procedures are also explained in
the How To instructions.

Learn to know the scoring rules by reading the help topic Scoring.

Tip: You can learn scoring rules also by examining the Points dialog box. The dialog box is
automatically displayed after each deal, and by comparing each players points to the tiles (they are
exposed after the hand is ended) you can easily see how each player’s tiles and hands are
evaluated.

When you feel comfortable with the game and the user interface, you can start examining the rule
variations. If you want to change the rules, make sure no game is going on. Choose Game Abort (or
press CTRL+Q), if necessary. Choose File Preferences and browse through the tabs of the Preferences
dialog box. You can access help for each of the options either by clicking on the Question mark button at
the right corner of the dialog box, or by clicking controls with the right mouse button and choosing What’s
This. If you want to alter the rules, first select Customized from the Rule Presets drop-down list box on
General tab.

For details on different rule options, press F1 while you have the Preferences dialog box open, or read
the help topic Variations.



Enables the extended tile set consisting of four Season tiles and four Flower tiles. These tiles are not used in tile sets, but they score
extra points and doubles (scoring varies in different versions of Mah Jong). The program automatically places extra tiles aside on
the right of the melded tiles and the tiles in the hand, and replaces each extra tile with a regular tile.



Enables using of Chows in the winning hand, i.e. tile sets consisting of three Bamboo, Character or Dot tiles in sequence. E.g., a
sequence of Bamboo 1, Bamboo 2 and Bamboo 3 composes a Chow. Disabling Chows makes the game more difficult and will
result in several hands ending in a Draw (no one wins).



Enables limiting the number of Chows allowed in a winning hand. The default value is 4 (no limit). Notice that certain hands (e.g.
Valueless Hand, Nine Gates, and Great Snake) are automatically disabled, if you limit the number of Chows. Declaring ‘Out’ with a
hand consisting of more Chows than allowed is considered a faulty declaration of Out, and the normal penalties are applied.

This option can’t be chosen, when the Hong Kong rules are used.



This option can be chosen if you allow claiming of Chows from any player. When enabled, a tile can be claimed from any player only
when going out on the claimed tile. In all other situations, a tile can be claimed only from the player on the left. If the option is
disabled, a Chow tile can be claimed from any player at any time.



Enables claiming of a Pair from any player, if the claimed tile is used to go out.



When enabled, a player is not allowed to claim a tile that is similar to his last discard.



When enabled, a player is not allowed to claim any tile that is similar to tiles he has discarded during the entire deal.



When enabled a player must/can (depending on the rule) declare ‘Ready’ before going out (in Riichi Mah Jong, this is not
obligatory). Declaring ‘Ready’ informs other players that a player needs only one tile to go out. This causes computer players to

slightly change their strategies as to their willingness to claim Chows, collect valuable sets, etc., and also makes them more careful
in choosing a discard.

If you enable the option, you must choose how you wish to apply the rule of Ready Hand. For options, see help for radio buttons
below.



When enabled, requires that a player declares a Ready hand, i.e., that he needs only one tile to go out. Computer players do this
right after they have received a tile that makes their hand ready. Human player must declare ready by clicking the Ready button, or
by using the equivalent command in the Game menu (CTRL+R). Notice that Four Winds does not check whether you really have a

“ready” hand, or not. You can use this feature to fool your opponents to change their strategies, if you think it's beneficial to you.
However, the computer players will not do this to you: they play honestly.



Applies the Japanese variation of the rule of Ready hand. This requires that the hand to be declared ready is completely concealed.
In addition, each player declaring a ready hand must pay 100 points. The player who wins the hand, will receive these points after
the hand is ended. The rule also requires that a hand is locked (i.e., it can’t be changed) after the declaration, and that the tiles are
turned face-down. Furthermore, a player must go out with the first possible tile (that is, he may not improve the hand in any way).
Winning a hand after declaring ready earns an extra double (plus 100 points for each player who declared ready).



Causes the deal to pass after a Draw, that is, a hand is not repeated after a game resulting in a Draw (no one wins).



Enables inclusion of limit and special hands in the game. The currently chosen limit and special hands can be seen in the Limit &
Special Hands dialog box, which can be accessed by clicking the Select button. Notice that you can change the settings in this
dialog box only if you have selected a customized rule preset.



Click to open the Limit & Special Hands dialog box, which allows you to see the limit and special hands currently included in the
game. To change the settings you have to select first a customized rule preset.



Enables calculating points for Lucky Pairs in loser’s hand (i.e., pairs composed of Dragons and pairs composed of player’'s Own
Wind or Wind of the Round). This option can be chosen only if points are settled between players.



Enables paying three doubles to losers for Little Three Dragons (i.e., a hand containing two Pungs or Kongs of Dragons, and one
Pair of Dragons). This option can be chosen only if points are settled between players.



Enables paying extra doubles to losers for Flowers and Seasons that correspond their own Wind. This option can be chosen only if
points are settled between all players.



Enables paying after a hand is ended in a Draw. Normally points are not paid when no one succeeds to go out. This option can be
chosen only if points are paid to the winner only. For more information on scoring, see Scoring.



Disabling this option requires that a hand is completely valueless, that is, the hand must be completed by going out on a discard,
and that tile must not be an only-chance tile. Normally this is not required, in which case no extra two points will be paid for going
out on a self-drawn or on an only-chance tile. Notice that a Valueless Hand may receive normal doubles (e.g., One Suit Only, All

Simples, going out on a last discard, etc.).



Enabling this option causes a penalty of up to three times the limit, whenever a player has made a faulty declaration of ‘Out’. Notice
that the hand always ends after a faulty declaration of ‘Out’. For more information on scoring, see Scoring.



Enabling this option causes a penalty of 100 points each time a player claims a tile erroneously, or cancels his claim. This penalty
can’t be chosen, when Hong Kong rules are used.



If there are five or less tiles left in the Wall, and the player discards a tile that has not been played already, and another player claims
the tile and goes out, the discarder must pay to winner on behalf of other players. This penalty is meaningless and can’t be chosen,
if you have applied a rule according to which discarder always pays for all players.



This penalty is applied, if one of the players has three (or four) melded Pungs or Kongs of the same suit, and another player
discards a tile of the same suit. If the discarded tile is claimed by the player having three sets of the same suit, and he goes out and
the winning hand is All One Suit, the discarder must pay to winner on behalf of other players. The penalty applies even if the player

claims the tile and composes a fourth set of the same suit, provided that he subsequently goes out on a self-drawn tile, and the
winning hand is All One Suit.



Enabling this option results in rounding of scores to nearest ten, according the method chosen with the radio buttons below. The
option can’t be chosen, when Hong Kong rules are used.



Enabling this option forbids a player to go out by claiming a tile he has “missed”, that is, a tile that is similar to a tile already
discarded by another player on the same turn. E.g., if East has a ready hand and he needs Bamboo 3 to complete a Pung of
Bamboo 3’s, and fails to claim the tile when it is discarded by South, he may not claim it later on the same turn (for example when
discarded by West, or North). Notice however, that if a Chow may be claimed only from a player on the left, including the situation,
where the claimed tile can be used to go out, it is acceptable to claim a tile that is similar to one discarded by other players (the tile
is not actually “missed* in this case, because it could not be claimed). Notice too that a missed discard can be legally claimed if the
player does not declare ‘Out’ immediately after his claim.



Enables claiming of a Chow only from a player on the left (i.e., from a previous player, seen from the claimer’s position), including
the situation where the claimed tile can be used to go out.



Enables claiming of a Chow from any player. You can modify this option by specifying that claiming from all is allowed only when
going out.



Specifies that the winner of a hand receives points from all losers, and losers pay to each other according the difference of their total
points. This rule tends to keep total point differences rather low, and accordingly, allows more freedom in choosing game strategies.



Specifies that points are paid only to the winner. The points are paid by all losers, if the winning tile is self-drawn, and solely by the
discarder, if the winning tile is a discarded tile. This rule accentuates both the element of luck and element of skill in the game, and
makes it much more adventurous: e.g., one unlucky discard may cost thousands of points to the discarder. The rule is used in the

official Japanese Mah Jong.



Specifies that points are paid only to the winner. The losers pay double, if the winning tile is self-drawn. Otherwise the discarder
alone pays double and other losers pay normally. Enabling this option applies Hong Kong style scoring rules. For more information,
see the help topic for Hong Kong Mah Jong.



Modifies the Hong Kong rules so that the discarder always pays on behalf of other players. Normally the discarder pays double and
other losers pay normally.



Enables rounding of points to nearest ten before calculating the doubles.



Enables rounding of points to nearest ten after calculating the doubles.



Click to open the Rule Presets pop-up menu, which allows you to save, rename and delete custom presets. To create a new preset,
choose ‘Customized’ from the Rule Presets drop down list box, change the options, and save the settings to a new preset using the
Save As New Preset command under the Rule Presets pop-up menu.



Click the arrow button on the right of the control to open a list of pre-defined and user-defined presets. Presets contain all the
settings of the Game, Point | and Point Il tabs, and allow you to quickly select a complete rule set for a game. You can create a
new preset by choosing ‘Customized’ from the Rule Presets drop down list box. To use an existing preset as a template, first select
that preset and then choose ‘Customized’. After editing the settings, you can save them to a new preset by choosing Save As New
Preset under the Rule Presets pop-up menu. To access the pop-up menu, click on the arrow button to the left of the Rule Presets
list box.



Adds or removes the Discards button at the bottom of the Game Board. Selecting this button displays the discarded tiles according
to the method chosen with the radio buttons below.



Shows each player’s discarded tiles using separate areas for each player.



Shows the discarded tiles in one area so that you can’t directly see which tile is discarded by each player.



Enables animation, which reveals whether a computer player discards a tile that he has received from the Wall, or a tile he already
had in the hand. If the discarded tile was already in the hand, the new tile (that was received from the Wall) slides into the hand. In
the Discards view the tile is zoomed in onto the Discarded tiles area. If the player discards the tile he received from the Wall, no
animation effect is used.



Clear to bypass the starting animation during the program start-up.



Allows displaying of hints in the message line. Hints include displaying the name of the tile the mouse cursor is currently over, and
information about the number each tile has been played so far .(To access this information, shift click on a tile.) The option also
enables or disables the Hint command on the Game menu. This command lets you see suggestion for the tile to be discarded. The
suggestion is based on the currently selected player type for Player 1.



Allows you to cancel your last discard by pressing the SPACEBAR or clicking on the discarded tile. Canceling can be done in two
seconds after the discard is done.



Allows you to restart the current hand.



Enter the time, in milliseconds, Four Winds waits before removing a discarded tile from the Discard Slot. Notice that you can
accelerate the game by hitting the ENTER key, or by clicking anywhere on the Game Board.



Click the tile to test the effect of fading out the tile. This effect is used when the discarded tile is removed from the Discard Slot.
Adjust the animation by using the equivalent frequency and delay controls.



Click the tile to test the effect of zooming the tile. This effect is used when a tile is added to or removed from the Game Board. Adjust
the animation by using the equivalent frequency and delay controls.



Click the tile to test the effect of rotating the tile. This effect is used when a hand tile is exposed. Adjust the animation by using the
equivalent frequency and delay controls.



Enter a frequency value for the Fade Out effect (range 0..10). The greater the value, the smoother (and slower) the animation.
Disable animation by setting the value to 0.



Enter a frequency value for the Zoom effect (range 0..10). The greater the value, the smoother (and slower) the animation. Disable
animation by setting the value to 0.



Enter a frequency value for the Rotate effect (range 0..10). The greater the value, the smoother (and slower) the animation. Disable
animation by setting the value to 0.



Enter a delay value (in milliseconds) for the Fade Out effect (range 0..999). The greater the value, the slower the animation.



Enter a delay value (in milliseconds) for the Zoom effect (range 0..999). The greater the value, the slower the animation.



Enter a delay value (in milliseconds) for the Rotate effect (range 0..999). The greater the value, the slower the animation.



Use up and down arrows to increase and decrease the frequency of the Fade Out effect (range 0..10). The greater the value, the
smoother (and slower) the animation. Disable animation by setting the value to 0.



Use up and down arrows to increase and decrease the frequency of the Zoom effect (range 0..10). The greater the value, the
smoother (and slower) the animation. Disable animation by setting the value to 0.



Use up and down arrows to increase and decrease the frequency of the Rotate effect (range 0..10). The greater the value, the
smoother (and slower) the animation. Disable animation by setting the value to 0.



Use up and down arrows to increase and decrease the delay of the Fade Out effect (range 0..999, in milliseconds). The greater the
value, the slower the animation.



Use up and down arrows to increase and decrease the delay of the Zoom effect (range 0..999, in milliseconds). The greater the
value, the slower the animation.



Use up and down arrows to increase and decrease the delay of the Rotate effect (range 0..999, in milliseconds). The greater the
value, the slower the animation.



Enter the name of this player (max. 12 characters).



Open the Skill list box to select a game strategy for this player. For more information about different player strategies, see the help
topic Player Types.



Enable to make this player behave more like a human player (occasional absent-mindedness, etc.). Don’t enable this option if you
wish to re-play saved games (that is, restart a saved game and repeat the moves exactly as they happened on the first time).



Specify initial points used when starting a new game. The default is 2000 for most versions of Mah Jong. The valid range is
0...10,000.



Specify a value for limit points (maximum total points for a single hand). The valid range is 50...10,000. Applying limit means that the
points exceeding the value of limit points will be ignored when calculating the final paying points for each player. This prevents other
players from going bankrupt in situations where one of the players has succeeded in collecting an exceptionally valuable hand.
Notice that the limit is applied to the tile points, not the paying points (for example, if East wins with a hand that earns limit points,
e.g. 500 points, he will receive from other players a total 3,000 points).

The value of limit points is 128 in the Hong Kong rules and the value can’t be changed.



Applicable only if you have chosen the Hong Kong paying method. The default for minimum points is 0, in which case all hands are
allowed as winning hands. Other possible values are 1, 2, and 3 points. Notice that declaring ‘Out’ on a hand with too few points is
considered a faulty declaration of Out, and normal penalties are applied.



Click to display the list of Acknowledged hands.



Click to display the list of Bonus & Double hands.



Displays a list of hands that are not acknowledged universally. Double click a name in the list to toggle its selection (applicable only
if you have selected a customized preset).



Displays a list of hands that score variably. Double click a name in the list to alternate the way a hand is scored (applicable only if
you have selected a customized preset).



Automatically displays the Wall Window at the beginning of each deal.



If the rule is applied the losers must pay bonus points to the dealer for his successive wins. When the dealer wins second time in a
row, he receives 300 points (24 points in Hong Kong Mah Jong) from the other players (100 or 8 points per player). Three
consecutive wins earns 600 or 48 points (200 or 16 points per player), and so on, with an increment of 100 or 24 points per each
consecutive win. After the seventh successive win, the dealer receives limit, after which the deal finally passes to the next player.



If checked, notifies you of a chance of robbing a Kong (i.e., claiming the tile another player intends to use for completing a melded
Pung to a melded Kong) by moving the mouse pointer over the Kong button (the caption of which has changed to read “Rob
Kong"), after which you have about five seconds to click the button and claim the tile for yourself, before your opponent completes
his melding.

If the option is unchecked, the computer player’s melding is interrupted only for few seconds, during which time you must click the
Rob Kong button to make your claim.



Changes the theme —i.e. the visual and aural design of the game. A theme affects the look of tiles, game board, dialog boxes,
controls and cursors, and contains sounds and background music particular to each theme. You can see the preview of the currently
selected theme and play and customize the sounds assigned to different game events. Additional theme plug-ins will be available in
the future.



Double click items in the list to hear the sound effect or music assigned to each item. To customize the sound, click the name of the
event, then select another sound file using the Name combo list box or the Browse button. To stop a sound, click a item in the
Sounds list.



Choose “Internal” to use the original sound of the theme, or select another sound from the list portion of this control. The list
contains the .wav or .mid files of the currently selected media folder. To change the folder, click the Browse button.



Opens a dialog box for browsing and selecting additional wave or MIDI files. You can preview sounds in the dialog box. The
contents of the last selected media folder are displayed in the list portion of the Name combo list.



Prints a simple character based report to a print file with the same path and file name as the saved game (4wtemp, if the game is
not saved) plus the extension .TXT.



Prints a report of all hands of the game.



Prints a report of the hand currently viewed in the Points dialog box.



Prints a report of the selected hands.



Specify the number of the first hand to include in the report.



Specify the number of the last hand to include in the report.



Prints a point summary of the entire game.



Ahand is called “one-chance” if it can be completed only with one possible tile (the actual number of tiles still left to be played does
not matter). E.g., if a player has Bamboo 1 and Bamboo 2 in the hand (in addition to a Pair) and he receives Bamboo 3 so that he
can complete the set to a Chow and go out, he receives 2 extra points. On the other hand, if a player has two Pairs in the hand, or a
Pair and two tiles in sequence which can be completed from either end (e.g. a sequence of Bamboo 2 and Bamboo 3), the hand can
be completed by two different tiles: the hand is not “one-chance”. Completing a pair always pays points for going out on a “one-
chance” tile.

Notice that there are cases where you can get 2 points for a "one-chance-only" hand though the hand can actually be completed
with two different tiles. E.g., claiming a tile for a pair (rather than Chow) in situation where a player has two Bamboo 1's, Bamboo 2
and Bamboo 3, gives two points for "one-chance-only", though the hand could be completed also with Bamboo 4. The player is free
to choose the winning combination: the remaining combinations are considered as "fixed". (If you receive this kind of multi-purpose
tile from the Wall, Four Winds automatically interprets the situation in a way that gives most points; if the tile is claimed, you must
make the choice yourself.)



Wind of the Round is called Prevailing Wind. The Prevailing Wind is indicated in the Status bar and in the Wall window.




A hand with two Dragon Pungs and one Dragon Pair. This usually earns three doubles (applies to losers, as well, if the appropriate
option is checked in the Preferences).



Going ‘out’ by taking the missing tile from a player who declares a Melded Kong (adding a tile he has received from the Wall to a
Melded Pung). This pays one extra double. If the robbed tile is Bamboo 2, the winner receives limit points (if the appropriate Limit
Hand is enabled).



Valueless Hand consists of a complete hand with mere Chows and an ordinary pair (other than a pair of Dragons or a pair of
player’s Own or Prevailing Wind). This pays the winner one extra double (or 10 points, depending on the rule). Normally it is
required that the hand must be completely valueless, in which case the hand must be completed on a discarded tile (that is, the last
tile must not be self-drawn), and the winning tile must not be a one-chance tile. Notice that a Valueless Hand can pay doubles
normally (e.g., three doubles for being One Suit Only, etc.)



A tile received from the Dead Wall as a replacement of a tile used for declaring a Kong or a Flower or Season tile received from the
Wall. Such a tile is also called a “loose tile” (because traditionally the supplement tiles are placed two at a time on top of the Dead
Wall as if tiles that are “loose”). Notice that each tile taken from the Dead Wall is replaced with a tile taken from the Wall, and as a
result reduces the number of tiles in the Wall by one. A player is not given a supplement tile after there are no tiles left in the Wall;

instead, the deal ends immediately after the last action that would normally result in receiving a supplement tile has been completed
(or after the player has made his last discard).



Bamboos, Dots and Characters are called Suit tiles. Only Suit tiles can be used to compose Chows.



A Bamboo, Dot or Character tile whose value is other than 1 or 9.



A Bamboo, Dot or Character tile whose value is 1 or 9.



Dragons and Wind tiles are called Honors.



Atile received from the Wall is a self-drawn tile.



Before the deal begins all 136 (or 144, if Seasons and Flowers are used) tiles are arranged in four rows (two layers per each row)
forming a square shape that resembles a wall. At the beginning of the deal the Wall is broken, and the dealing of tiles is started on
the first tile left to the breaking point. The 14 tiles to the right of the breaking point comprise the Dead Wall (or the Ruin).



The 14 tiles to the right of the breaking point of the Wall comprise the Dead Wall (or the Ruin). Supplement tiles are taken from the
Dead Wall. Each tile taken from the Dead Wall is replaced by a tile taken from the end of the Wall. There are always 14 tiles in the
Dead Wall. Notice that when there are no tiles left in the Wall (that is, the only tiles left in the game are the 14 tiles in the Dead Wall),
the deal ends immediately when a new tile is needed in the game. That means, among other things, that a player can't receive a
supplement tile for a declared Kong or an Extra tile (a Flower or a Season) after there are no tiles left in the Wall.



A set of three similar tiles, e.g., three Bamboo 3’s. Since there are four of each tiles in a complete Mah Jong tile set, a Pung can be
composed of any of the tiles in the set.



A set of four similar tiles, e.g., four Bamboo 3’s. Since there are four of each tiles in a complete Mah Jong tile set, a Kong can be
composed of any of the tiles in the set.



A set of three tiles in sequence, e.g., Bamboo 1, Bamboo 2 and Bamboo 3. Since the Honor tiles (Dragons and Winds) don’t have
numerical values, you can compose a Chow only of the Suit tiles. Suit tiles are numbered from one to nine and there are four of
each Suit tile. Chows give no points.



As a player discards a tile, any player can require, or claim, it in order to compose a set (a Chow, a Pung or a Kong, and in some
cases, also a Pair). For more information, see Claiming another player’s discard.




When a tile is claimed from another player, the resulting set must be put aside and exposed to other players. This is called “melding*
a tile set. Once a set is melded, its component tiles can’t be used for other combinations. Melded tiles are placed above each
player’s hand. Notice that declaring a Concealed Kong closely resembles melding a Kong: in both cases the tiles are exposed and

put aside and can’t be used for other combinations, but in the previous case the 1st and 4th tiles are turned face-down as to mark
the set as concealed.



When a tile is discarded, it is zoomed out from the discarding player’s hand and zoomed in on the claim column into a framed area
called a Discard Slot. Each player has his own Discard Slot, identified by players wind and his name. The discarded tile can be
claimed by any player as long as it is visible in the Discard Slot. To claim a tile that is in the Discard Slot, click on it (the shape of the
cursor changes), or press the SPACEBAR.



When one of the players has four complete sets and a pair, he can end the current deal by declaring ‘Out’. You can go out by
clicking the Out button on the Status bar or in the Tile Claimed dialog box, depending on whether you receive the winning tile from
the Wall or by claiming it from another player. Notice that rules may require that a player declares ‘Ready’ (i.e., that he needs only
one tile to complete his hand and go ‘out’) before going out. If this is the case, the Status bar contains a button with the caption
Ready, instead. After you have declared “Ready” (and discarded one of the tiles in your hand), the button changes to read “Out".



Substantive: When there are no tiles left in the Wall, and none of the players succeeds to complete his hand and go out, the hand is
said to end in a Draw. Notice that if a player declares a Kong with the last tile of the Wall, or receives an Extra tile (a flower or a
season) as a last tile from the Wall, the deal ends immediately and no supplement tiles are given. Usually no points are calculated
nor paid after a Draw. According to the official Japanese rules the deal passes after a draw, but in other versions of Mah Jong the
hand is normally played again. The Draw rules can be customized in the Preferences dialog box.

Verb: To take (receive, in this context) a tile from the Wall.



Aftile in the hand as opposed to a tile that is melded and exposed to other players. Notice however, that a Concealed Kong is also
exposed to other players.



In real Mah Jong, the player who is currently East is responsible for dealing the tiles. The dealer starts a hand, and after the hand is
ended, he receives and pays double. Normally, if the dealer wins, the deal does not pass. Otherwise the next player in turn becomes
the dealer (that is, East becomes North, North becomes West, West becomes South and South becomes East).



Atile set that is composed by claiming one of the tiles from another player’s discard. A melded tile set is placed face-up above the
player’s hand. Notice that a Concealed Kong, though visible to all players, is not melded (the first and fourth tile are placed face-
down to make it different from a Melded Kong).



A complete game of Mah Jong consist of four Rounds (East, South, West and North), which in turn consist of at least four hands, so
that each of the players has been a dealer at least once per a Round. There are often more than four hands per round, since

normally the deal does not pass if the dealer (East) wins, and in the popular Mah Jong, the deal is normally played again if the hand
ends in a Draw.




A deal of tiles that ends in one of the following situations: a) one of the players goes out, b) one of the players makes a faulty
declaration of ‘Out’, ¢) hand ends in a Draw.



Normally the winds change places in a counter-clockwise direction after a hand is ended. East wind, which marks the dealer, passes
to the next player in turn. Notice that if East wins, the deal normally does not pass, and in the popular Mah Jong, the deal does not
pass if the hand ends in a Draw.



A Round consists of at least four deals so that each player has been East (dealer) at least once. There are often more than four
deals per round, since normally the deal does not pass if the dealer (East) wins, and in the popular Mah Jong, the deal is normally
played again if the hand ends in a Draw. Notice that sets composed of the Wind of the Round (like sets composed of player’s own

wind) pay two times more than sets composed of ordinary winds. Notice too, that a Pung or a Kong of Wind of the Round (or
player’s own wind) is worth one double.



Hands that automatically pay limit points. A limit hand can be composed of irregular sets. E.g., Thirteen Orphans is not composed of
regular Chows, Pungs, Kongs and a Pair. There are about ten Limit Hands that are universally acknowledged. For more information,

see Scoring.



Hands that pay a fixed amount of points. A special hand can be composed of irregular sets, e.g., seven pairs. For more information,
see Scoring.



For short, ‘limit’. The maximum amount of tile points any player can score per hand. Notice that this is not the same as the paying
points. E.g., if the limit is 500 points, and the winner is East, he will receive 1,000 points from each of the other players, so that the
total of paying points amounts to 3,000.



A hand that is one tile short of being complete. Certain rules may require that a player declares ‘Ready’, that is, informs other
players of having a nearly complete hand, before he can go out.



See Prevailing Wind.



A complete hand is composed of four sets and a pair. The sets are as follows: Chow (a sequence of one Suit), Pung (three similar
tiles) and Kong (four similar tiles). A set can be composed of tiles received from the Wall (a concealed set), or completed by claiming
the missing tile from another player’s discard (a melded set).



Arule that forbids a player to claim a tile that is identical to his last discard.



A rule that forbids a player to go out on a discard that he has missed (after his last move, and before he has made his next draw or a
legal claim). Notice that it is legal to claim a missed discard if the player does not go out immediately after the claiming.






